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General Installation Procedures

Creating an SAi Cloud account

SAicloud.comis the platform through which EnRoute software and licenses are distributed. Users create an accountin
SAicloud.com and activate their software to that account. Multiple licenses can be activated to the same account.

If your company has multiple licenses, choose a general business email address to create the saicloud account with. The
chosen email address will be the user name of the account and all communication regarding password resets will be
senftoit.

When you purchased a Version License, you received an Activation Code.

»  Browse to http://saicloud.com

»  Paste the activation code in the corresponding field and click Activate to continue.

” Ifyou already have an saicloud account, you can log in using the email address and password you previously
created.

» | thisis your first time activating an sai product, select "l am new to the SAi Cloud"

?  Enter the email address you want to use for your saicloud account. This will be your username.

”  When you click Create Account, an email will be sent to you containing a link to confirm your activation.
Be sure to check spam orjunk folders if the email did not arrive.

»  Either click the link or copy and paste it into a browser.
Your email address will already be entered and cannot be changed at this time.

» Choose a password with atleast 6 characters and retype it to confirm

»  Enterin further details and click Create Account
» Read through the Terms and Conditions and Accept.
»  Click Activate Now to confirm and link the license to the account.

You have now created an saicloud account and activated your software on that account. Having an saicloud account
means you can log backin at any time to download software again, get updates and manage your licenses.

Downloading the software

When you activate your software, or when you log into saicloud.com at alater fime and select your software, the fol-
lowing detail page will be displayed:

»  Hit the Download Now button.

A small tool with the name SAi_software_download.exe will be downloaded.
»  Choose to Run or Open this tool when the download s finished.

This will launch the Installation Tool , which will start downloading all the necessary installation files
»  Once the tool has finished downloading and extracting files, the installation can begin.

»  Click Yes and choose the language for yourinstallation.

»  Follow the instructions of the Installation Wizard.

Installing the software

At the end of the download of your software, Installer will be launched automatically.
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»
»
»
»
»
»

To install the software, you must have Administrator privileges. To use the software, you must have Admin-

istrator or Power User privileges. See your Windows user guide for more information.

Select yourlanguage

Click Nextin the Welcome to the InstallShield Wizard screen.
Select| Accept the Terms of the License Agreement and click Next.
Click Next to accept the default Destination Location folder.

Click Next to accept the default Select Features.

Click Next to create a Program Folder fo hold the program icons.

The Setup Status window appears, and the software installation process begins. When the installation completes,
License Manager will launch.

»
»
»

Enter your product Activation Code and click Next.
Click Next when the Licensing Successful message appears.

Click Finish in the InstallShield Wizard window. (This last window may be hidden behind other open windows.)

After the software has finished downloading, a folder with the name SAI_Installeris created on your desktop. If
you interrupted the installation at any point, orif you need to reinstall, you can double click autorun.exe from

within this folder to launch installer again.
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Using License Manager.htm

General Information

Software License Agreement

IMPORTANT READ CAREFULLY: This Agreement (as defined below) is alegal contract between You (as defined below)
and SA International Inc. for Flexi, PhotoPrint, EnRoute, or PixelBlaster branded Software (as defined below).

This Agreement (as defined below) sets forth the terms and conditions for licensing of the Software from SA International
Inc. and You (as defined below), and installing and using the Software. This Agreement applies to any (i) single-user
license; (i) multi-user license; and (i) original equipment manufacturer (OEM) or Special Edition (SE) versions of the Soft-
ware and other branded or customized versions unless otherwise agreed.

BY OPENING THE SEALED PACKAGE CONTAINING THE SOFTWARE OR DOWNLOADING THE SOFTWARE FROM AN
AUTHORIZED ON-LINE SITE, OR OTHERWISE USING THE SOFTWARE, YOU AGREE THAT YOU HAVE READ, UNDERSTAND, AND
AGREETO BEBOUND BY THE TERMS OF THIS AGREEMENT AND ANY THIRD PARTY LICENSE AGREEMENTS REFERRED TO
HEREIN, INCLUDING THE WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY, JURISDICTION, AND TERMINATION
PROVISIONS BELOW. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT OPEN THE SOFTWARE PACKAGE,
INSTALL, OR USE THE SOFTWARE APPLICATION. RETURN THE SOFTWARE WITH YOUR PURCHASE RECEIPT FOR A FULL REFUND.
IF YOU PURCHASED AN AUTHORIZED DOWNLOADABLE VERSION OF THIS SOFTWARE, TERMINATE THE DOWNLOAD AND
YOU WILL NOT BE DEBITED.

DEFINED TERMS

Acts means the Export Administration Act of 1979, as amended, and the Export Administration Regulationsissued there-
under.

Agreement means this End-User License Agreement, including any third-party licenses provided to SA International Inc.
for use of the Software.

Intellectual Property Rights means, by way of example, but is not limited to, the following: rights in know-how, trade-
marks, copyrights, patents, patent applications (including reissues, renewals, continuations, continuations-in-part, or divi-
sions of any patent or patent application, as appropriate), trade secrets, instructions, improvements, modifications,
suggestions, proposals, programs, ideas, writings, and the like of any sort whatsoever, and any embodiment thereof
including, but not limited to, computer programs, documentation, assembly and detailed drawings, plans, spe-
cifications, results of technical investigations and research, assembly, and parts manuals, artwork, software, pro-
gramming, applets, scripts, designs, and any other proprietary information of orin connection with the Software.

Information means any type of data You provide to SA International Inc. in any form or mannerin connection with: (i) the
purchase of the license to use the Software, (ii) the registration of the license to use the Software; (iii) in connection with
Support Services; orin any other communication between You and SA International Inc. arising out of the use of the Soft-
ware whether provided by You or the Software in any media and any form now known or hereafter existing. By its oper-
ation, the Soffware may provide data to SA International Inc. indicating the operation of hardware upon which orin
connection with the Software may operate and the status, type, and use made of disposable materials in connection
with the operation of the Software. Such data shall be included in the definition of Information.

In Use means that the Software isloaded onto either temporary (i.e., RAM) or permanent non-portable memory (e.g., a
hard disk, a CD-ROM or other storage device) for that Workstation or other personal computer.

Materials means any applicable, associated documentation for use in connection with the Software as provided by SA
International Inc. in any medium such as, by way of example, printed materials or On-Line.

Network means any electronic system for communicating fo more than one PC and where such PCs are physically loc-
atedin the same premises, except as expressly provided herein.

On-Line means communications by means of the Internet or World Wide Web.
PC means a personal computer.
Software means, separately or together, the above-identified computer software.

Support Services means any services which SA International Inc. determines to provide inits sole discretion to maintain
the operation of the Software.

You or Your means you, any other entity on whose behalf you are acting, and anyone who you or such entity authorizes
to use the Program.
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LICENSE TERMS

The Software is protected by the United States Copyright Law and International Treaties and other Intellectual Property
Rights. The copyrights in the Software should be respected by You just as You would any other copyrighted material,
such as a book.

You may make one (1) copy, in machine readable form only, of eachregistered copy of the Software; provided that
each such copy is used solely for backup purposes (i.e., for the purpose of reinstalling the Software). As an express con-
dition of this Agreement, if You make such a copy, a condition of making that copy is that You shall reproduce and
place on any such copy SA International Inc.'s copyright notice and any proprietary legends as set forth on orin con-
nection with the original copy or as appears or may appear on any On-Line site maintained for that purpose by SA Inter-
nationalInc. The right to make a backup does not extend to any Mafterials.

You may transfer Your registered copy of the Software, but only with the assignment of all of Yourrights and obligations
under this Agreement, fo another person or entity and only accompanied by a copy of this Agreement and only the ori-
ginal Material accompanying the Software. To make this fransfer You and the party obtaining the Software shalleach
first give SA International Inc. written or On-Line notice of the transfer which must include that the person or entity has
read, understands, agrees, and accepts the terms and conditions of this Agreement and further provided that You
retain no copies of the Software or the Materials.

Except as expressly provided in this Agreement, SA Infernational Inc. does not grant You any rights fo patents, copyrights,
trade secrets, frade names, frademarks (whetherregistered or unregistered), or any otherrights, franchises, orlicensesin
respect of the Software. You will not adapt or use any trademark or frade name whichis likely to be similar to or confusing
with those of SA International Inc. or any of its suppliers or licensors or take any other action which impairs orreduces the
frademark rights of SA International Inc. orits suppliers or licensors.

Single-User License. If you have purchased a single-user license of the Software, you are, by this purchase, granted a lim-
ited non-exclusive license to use the Software. If not already installed on a PC you may install the copy on that one (1)
PC. You may access and use the Software on that PC only.

If you are a private business, rather than anindividual, authorized personnel associated with the business may use the
Software, but only one (1) person at a time and on that one (1) PC.

Foryourregistered copy of the Software you may make one (1) backup copy which is restricted to your individual use,
for backup purposes only, and only for so long as the Software is installed on one (1) PC.

Multi-User License. If you purchased a multi-user license, you are granted a limited non-exclusive license to (i) use the Soft-
ware on the number of PCs corresponding to the number licenses purchased (but only one (1) person may use the Soft-
ware onone (1) licensed PC) and only where all such PCs are owned by you, (i) make the Software accessible through
the Network so that each licensed PC may use the Software, and (i) make a backup copy of the Software for each
license you have purchased. You may store, install, and access the registered network version of the Software via the
Network, and only for each licensed PC that will or may access the Software. For example, if you wish to have five (5) dif-
ferent PCs (counting the server) access the Software on the Network, each PC must have its own paid-up license, regard-
less of whether or not any of the PCs use the Software at different times or at the same time.

You may use On-Line communications fo operate the Software subject to the above terms and conditions and further
provided that you own each PC and that each PC has its own paid-up license. For example, if you are communicating
by means of a PC On-Line to another PC, each PC accessing the Software must have its own paid-up license.

Except as expressly provided herein, it is prohibited to give any copy of the Software to someone who has not purchased
alicense from SA International Inc.; to disclose interfaces to the Software, or to duplicate or distribute the Software by
any other means including electronic fransmission.

UNAUTHORIZED DISTRIBUTION

The Software is protected by copyright and also contains frade secrets owned by SA International Inc. You shall NOT dis-
fribute copies of the Software to others or electronically fransfer the Software from one PC to another over a Network,
except as expressly provided in this Agreement. You shall not modify, adapt, transfer, rent, lease, loan, resell for profit, or
distribute the Software, nor shall you decompile, reverse engineer, disassemble and/or otherwise reduce the Software to
ahuman-perceivable form or create derivative works based upon the Software or any part thereof.

SUPPORT SERVICES

Use by you of Support Services is governed by SA International Inc.'s policies and programs described in the user manual,
in documentation made available On-Line, and/orin other SA International Inc.-provided materials. Any supplemental
software code provided to you as part of the Support Services shall be considered part of the Software and subject to
the terms and conditions of this Agreement.
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INFORMATION

You expressly agree that SA International Inc. may use Information in its business, including for product support and
development. You agree that SA International Inc.'s use of the Information is unrestricted and non-confidential and You
automatically grant SA International Inc., its successors and assigns, a non-exclusive, royalty-free, worldwide, perpetual,
irevocable license in all Intellectual Property Rights in the Information, which includes the unrestricted right to use the
Information in any way SA International Inc. wishes, including, by way of example and without limitation, to sublicense,
copy, transmit, distribute, create derivative works, display and perform. You expressly waive any claim to aright of pub-
licity orright of privacy or moral rights in such Information.

TERMINATION

Without prejudice to any otherrights, SA International Inc. may terminate the Agreement if you fail to comply with any of
its terms and conditions orif you violate SA International Inc. "Acceptable Use Policy" which is posted upon SA Inter-
national Inc. at www.saintl.biz, or such otherinternet-accessible location as SA International Inc. may determine at its dis-
cretion. In such event, you shall destroy all copies of the Software (including all of its component parts) and Materials. SA
International Inc. may suspend or deactivate your use of the Software with or without notice. SA International Inc.
reserves the right to discontinue all support for the Software. SA International Inc. willendeavor to notify you of any such
discontinuance of such support but assumes no obligation to do so. From time-to-time SA International Inc. may change
the ferms and conditions of this Agreement. Your continued use of the Software indicates your agreement to any such
changes.

GOVERNING LAW AND JURISDICTION

The Agreement shall be governed by the laws of the State of Utah and jurisdiction for any dispute, except as expressly
provided herein, shall be exclusively within the courts located within the State of Utah.

ARBITRATION

Any dispute arising directly orindirectly under Agreement may, af SA Infernatfional Inc.'s sole and exclusive discretion, be
submitted to, and settled by arbitration by at least one (1) arbitrator. The arbitration shall be conductedin accordance
with the rules for conducting arbitration by an organization previously established for conducting arbitration, which arbit-
ration shall take place in Murray, Utah, or such other locationin Utah as may be chosen by SA International Inc. Each
arbitrator shall strictly apply Utah law, the Federal Rules of Evidence and the terms of this Agreement and shallhave no
power to strike, amend, or modify said terms. Any such proceeding shall, at the exclusive discretion of SA International
Inc. be held in confidence by all parties and witnesses. The judgment or the award rendered by the arbitrator(s) may be
entferedin any court having jurisdiction thereof and there shall be no trial de novo. At the sole discretion of SA Inter-
national Inc. the arbitrator(s) may have equitable powers including the right to issue temporary restraining orders and
preliminary injunctions.

PROPRIETARY RIGHTS

Allright, title, and interest in and fo the Intellectual Property Rights in the Software (including, without limitation, any
images, photographs, animations, video, audio, music, text, and "applets" incorporated into the Software), the Mater-
ials, and any copies of the Software are owned by SA International Inc. except that which is owned by its suppliers or
licensors. Use of any Intellectual Property Rights is restricted fo the rights expressly licensed herein and none other are
granted.

DISCLAIMER OF WARRANTY

THE SOFTWARE IS PROVIDED "AS IS." SA INTERNATIONAL INC. AND TS SUPPLIERS AND ITS LICENSORS DO NOT AND CANNOT
WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE OR SUCH FILES. SA INTERNATIONAL
INC. AND ITS SUPPLIERS AND LICENSORS MAKE NO WARRANTIES, EXPRESS OR IMPLIED, AS TO TITLE OR INFRINGEMENT OF
THIRD-PARTY RIGHTS, INCLUDING, BUT NOT LIMITED TO RIGHTS IN INTELLECTUAL PROPERTY RIGHTS, AND MERCHANTABILITY
OR FITNESS FOR ANY PARTICULAR PURPOSE.

IN'NO EVENT SHALL SA INTERNATIONAL INC. OR ITS SUPPLIERS OR LICENSORS BE LIABLETO YOU FOR LOST DATA, LOST
PROFITS, COST OF COVER OR OTHER ANY CONSEQUENTIAL, INCIDENTAL, OR SPECIAL DAMAGES, EVEN IF A
REPRESENTATIVE OF SA INTERNATIONAL INC. HAS BEEN ADVISED BY YOU OF THE POSSIBILITY OF SUCH DAMAGES OR FOR
ANY CLAIM BY ANY THIRD PARTY.

These limitations apply evenif SA International Inc. or an authorized dealer or distributor has been advised by you of the
possibility of such damage. SA International Inc. does not warrant any drivers for plotting, scanning or other devices.
Drivers are provided to you as a service only, and were developed using information provided to us at the time by equip-
ment manufacturers.

SA International Inc. is not responsible for any typographical errors in the Software or Materials.
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SA International Inc. intends fo maintain Information in accordance with SA International Inc.'s understanding of industry
practices but assumes no responsibility or liability in connection therewith.

This Agreement sets forth SA International Inc.'s entire liability and your exclusive remedy with respect to the Software
and the use thereof.

This Agreement does not limit any rights that SA International Inc. may have under frade secret, copyright, patent, frade-
mark, or other laws. No representative of SA International Inc. is authorized to make any modification fo this Agreement,
or make any additional representations, commitments, or warranties binding upon SA International Inc.

INTEGRATION

This Agreement constitutes the full and complete agreement between the parties with respect fo the within subject mat-
ter and supersedes all prior negotiations and agreements (whether written or oral) between the parties.

DEFINITIONS AND HEADINGS

The definitions provided herein are referred to herein by bold and italicization throughout this Agreement. The definitions
of such terms are understood to be applicable to both singular and plural uses of such defined terms.

The titles of this Agreement are inserted for convenience only and shall not be construed as limiting in any manner.
AMENDMENTS

No amendment or modification of this Agreement shall be valid or binding unless the same shall be made in writing and
signed on behalf of each party.

WAIVER

The failure to enforce any of the terms and conditions of this Agreement by SA International Inc. shall not be deemed a
waiver of any otherright or privilege under this Agreement or a waiver of the right to thereafter claim damages for any
deficiencies resulting from any misrepresentation, breach of warranty, or nonfulfillment of any obligation.

In order for there to be a waiver of any term or condition of this Agreement, such waiver must be in writing and signed by
the party making such waiver.

SEVERABILITY

If any provision of the Agreement is found invalid or unenforceable pursuant to judicial decree or decision, the
remainder of this Agreement shall remain valid and enforceable according to its terms. Without limiting the foregoing, it
is expressly understood and agreed that each and every provision of this Agreement that provides for a limitation of liab-
ility, disclaimer of warranties, indemnification or exclusion of damages or otherremedies is intended by the parties to be
severable and independent of any other provision and to be enforced as such. Further, it is expressly understood and
agreed that if any remedy hereunderis determined to have failed of its essential purpose, all limitations of liability and
exclusions of damages or other remedies set forth herein shallremain in effect.

GOVERNMENTREGULATIONS

If you are a U.S. Government end-user, this Agreement conveys only "RESTRICTED RIGHTS," and its use, disclosure, and
duplication are subject to Federal Acquisition Regulations, 52.227-7013(C) (1) (ii).

EXPORT REGULATIONS

Notwithstanding the location of any PC herein, You represent and warrant that, as required by the Acts that, unless You
obtain prior authorization from the United States Office of Export Administration, You will not knowingly re-export, directly
orindirectly, nor knowingly allow any other person or entity to re-export, the Software supplied for any purpose to any of
the countries to which such re-exports are prohibited. Your obligation hereunderis subject to the Act, which obligation
shallsurvive the expiration or termination of this Agreement so long as the relevant Actremains in effect.

ATTORNEY'S FEES

Should SA International Inc. prevail in any lawsuit, action, or proceeding in contract, tort, or otherwise which arises out of
orrelated to this Agreement, SA International Inc. shall be entitled to recover all of its costs and expenses including,
without limitation, its reasonable attorneys' fees incurred in connection with such lawsuit, action, or proceeding, includ-
ing any appeal of such lawsuit, action, or proceeding.

SALES ACROSS INTERNATIONAL BOUNDARIES

As between the parties hereto, and in the sale and delivery of any goods, the United Nations convention related to the
sale of goods shall not apply to any sale of goods deemed to arise under in this or any other agreement between the
parties.
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© Copyright 2011 by SA International Inc., Allrights reserved. No part of this publication may be reproduced, stored in a
retrieval system or fransmitted, in any form or by any means, electronic, mechanical, photocopy, recording or oth-
erwise, without the prior written permission of the publisher. Printed in the United States of America. The information in this
manualis subject to change without notice and does not represent a commitment on the part of SA International Inc.

The names of actual companies and products mentioned in the Software may be the trademarks of theirrespective
owners or their subsidiaries or affiliates and may be registered in certain jurisdictions.

Recommended System Requirements

Supported Operating Systems Windows 10
Windows 8.1
RAM 8 GB
Installation Space 1GB
Working Disk Space 4 GB
Other Broadband Internet connection

Available port for output device if it is connected to the same
computer.

Software License Types

EnRoute is available in two different license types.

Subscription Licenses

Users with subscription licenses pay a monthly fee for the usage of the software. Aslong as the subscriptionis active, all
upgrades and new features are available to the subscription user at no additional cost.

Version Licenses

Users with Version Licenses paid a one-tfime fee for a particular version of the soffware. Upgrades and new features are
available only at an additional upgrade cost.
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The EnRoute Workspace

The workspace within EnRoute has several built in features to assist with designs.

Rulers

Rulers can be added to the Top, Right, and Front views. Rulers provide an easy way to add guidelines to a drawing, click
on the ruler and drag into the workspace to create a new guideline.

Hiding and Displaying Rulers

Rulers can be hidden or displayed by navigating to the View > Rulers menu. Click on a view name to add orremove
rulers from the view.

Toolbars

EnRoute tools are activated by selecting the corresponding tfoolicon from the foolbarribbon at the top of the display.
Hover over eachicon to preview the name of each tool.

All'tools can also be found in the menu (File, Edit, View, etc.) at the top of the screen.

Hiding and Displaying Toolbars

Toolbars can be hidden by navigating to Setup > Toolbars. In the drop down menu, all toolbars with a check mark will be
visible in the ribbon. Click on a tfoolbar to hide or display it in the ribbon.

Toolbar Drop Down Menus

Tools with similar functions can be grouped together under the same toolicon and accessed by a drop down menu. A
drop down menu can be opened by selecting the drop down arrow to the right of a toolicon. The last used tool from a
fool grouping will be shown as the top levelicon in the fool ribbon.

DYOvAvE-

Layers

Layers provide a method to separate drawing elements so unused information can be hidden when it is not being used.
Objectsin different layers can be displayed in different colors to distinguish different parts of the design.

Layers Toolbar

7

Enable the Layers toolbarin Setup > Toolbars > Layers. The layers toolbar provides a selection box to choose a specific
layer to display.

The Activate all Layers i button makes all layers visible.
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Layers Dialogue

2

Each layer has several options: On, Off, Lock, and Move Lock. A check box indicates the option is enabled for the selec-

ted layer.

On

Off

Lock

Move Lock

Layer Operations

Select the Current
Layer

Add a New Layer

Delete Layers

Remove Empty
Layers

Rename a Layer

Change the Color
of a Layer

Moving Layers
Hide or Display
Layers

Lock a Layer

Save Changes and
Exit

Cancel Changes

Change Layer

All objects in the layer are displayed and selectable
None of the objects in the layer are visible and none can be selected

All Objects in the layer are displayed but cannot be selected. Drawing tools will still snap to
locked geometry.

All Objects in the layer are displayed and can be selected, but cannot be moved.

Check the Current box for that layer.

Click New. The new layer is added to the bottom of the list and is selected as the current
layer.

Select layer and Click Delete. All objects within the layer will also be deleted.

Click on Remove Empty button.

Edit the text in the name column for that layer.

Click on the color displayed next to the layer to open the color selection dialogue. Select a
new color and click OK.

Select the layer and click Move Up or Move Down. Layers can also be moved by clicking and
dragging the row header at the left edge of the list.

In the On and Off Column, check On to display a layer, check Off to hide a layer. The current
layer cannot be hidden.

Check the Lock option. Clear the check to unlock the layer.

Click OK.

Click Cancel to discard any changes.

1. Selectthe objects to change layers

> 0D

Activate the Change Layer command
Click on the new layerin the dialogue window. The current layer and new layer will both be displayed
Click OK
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oom

The workspace view can be changed by zooming in to view detail, or zooming out to see the entire composition. Zoom-
ing does not affect the dimensions of the design, only the view of the design information.

Zooming with the Mouse

Hold Ctrl and right click and drag left to zoom out, drag right to zoom in. The mouse wheel can also be used to zoom,
scroll backwards to zoom out and forwards to zoom in. The mouse wheel zoom is centered on the cursor location which
makes it ideal forzooming in on specific points.

Zoom Commands

Zoom Win- Click and drag to define an area to magnify
dow
Zoom In @ Zoom in towards the center of the window
Zoom Out a Zoom out and enlarge the view of the design
Zoom to Display the extents of the plate
Plate Q
Zoom Pre- Return to previous zoom level
vious Q
Zoom to Zoom in on the currently selected objects. If all four views are active, all views will
Extents of zoom to the extents of the selection
Selection
Zoom to Zoom out to display all objects including the plate. If all four views are active, all views
Extents of will zoom to the extent of the objects
All Objects
Guidelines

Guidelines are design aids displayed as dashed lines in the workspace. Guidelines allow for precise placement of points
within the drawing. When Snap to Guideline is enabled, contours moved near a guideline will automatically be posi-
fioned along the guideline, or at the intersection of two guidelines.

Create Guideline
The easiest way to create a guideline is fo click on the horizontal or vertical ruler and drag a guideline into the work-
space. A new guideline can also be created by using the Edit Guideline Dialogue.

Edit Guidelines Dialogue

Open the guideline dialogue by opening View > Edit Guideline, or by right clicking on an existing guideline and selecting
Edit Guideline. The guideline dialogue provides parameters to define the X, Y, and Z coordinates and the angle of a
guideline. When multiple guidelines are active in the workspace, the Next button willmove through the guidelines. The
active guideline will change fromred to blue, and the parameters will display in the dialogue.
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Snaps

New Create a new guideline at the specified position

Delete

Move

Rotate

Lock Guides

Hide Guides

Hide all guidelines

Delete the selected guideline
Move the guideline to the specified coordinates
Rotate the guideline by the specified angle

Prevent all guidelines from being moved

Snaps allow specific geometric features to be selected while using drawing and editing fools. Most drawing fools will
automatically move the cursor to drawing elements that meet the active snap criteria.

Snap to Grid

Snap to Guideline

Snap to Intersection

Snap to Endpoint

Snap to Contour

Snap to Arc Center

Snap to Midpoint

Snap to Per-
pendicular Point

Snap to Tangent
Point

A A4 2 N AR [T A

Snaps to the nearest grid point, as defined in Setup >
Preferences > Grid

Snap cursor to guideline. Contour boundaries will also
snap to guidelines when dragged

Snap to the intersection of two line segments

Snap to the endpoints of arc, curve, and line segments

Snap to the nearest point along a contour

Snap to the center of an arc segment when the cursor is
placed near the arc

Snap to the midpoint of a segment

When constructing line segments, after defining the first
point in the segment, the second endpoint will snap to a
point on a contour so that the line segment will be per-
pendicular to the contour.

When constructing line segments, the second endpoint
will snap to a point on an arc so that the new line seg-
ment will be tangent to the arc

EnRoute User Manual - Page 16

Tt © k0 Xox

o



Snap to Tangents
Between Two Circles

secting Contours

Snap to Show Inter- %

Views

When in a construction tool, the snap identifies the tan- \G/
gent point to the nearest arc segment as well as cor-
responding tangent point on an adjacent arc segment

Toggles the display of intersecting or overlapping con- AQ}
tour segments. This Snap is most useful in identifying

potential toolpath creation issues before generating

toolpaths.

The main display area shows a view of the workspace. The display can be adjusted to show a Top, Right, Front, or Per-
spective view of the workspace, or all four views at the same time. Top view is the default view and is where most design

work will take place.

The name of each view is shown in the upper left hand corner of the view window. Double click the view name to open
the four panel view window and double click the view name again fo maximize the single view.

Top view and perspective view can be toggled between pressing the F12 key

Redraw

5

Redraw is used to refresh the screen and clear any remnants left over from manipulating drawing elements. Press Ctrl
+ Rtoredraw, orselect Redraw from the View menu.

Snapshot

Yoy

Save animage of the active view.
1. Activate the snapshot command
2. Selectalocation to save the image

3. ClickSave
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Preferences

E

The behavior of EnRoute can be adjusted through user preferences. To open the preferences menu, select Setup >
Preferences.

General

Merge Contours

Define the behavior for merging open contours when importing from other drawing programs.

Import Merge contours onimport
Paste Merge confours when pasted
Tolerance Maximum separation between contour endpoints that will still be merged

Auto Cleanup

Control if short segments are automatically deleted when imported or pasted.

Import Delete short segments when contours are
imported
Paste Delete short segments when contours are

pasted from the clipboard

Tolerance Maximum segment length to be deleted

Undo Operations Limit

Controls the number of operations that can be undone by the Undo command.
Unlimited All operations since the last save can be undone

Limited Only the specified number of actions can be undone

Save

Specify an auto save time interval

Avuto Save Enables automatic saving functionality
Time Interval The fime interval between automatic saves
Toolpath
Scaling of toolpath Allow toolpath groups to be scaled when checked. When a toolpath group is
groups scaled the toolpaths will automatically be recalculated using the original

strategy parameters. If unchecked, foolpath groups cannot be resized.

Clip toolpaths to plate Output toolpaths will not extend beyond plate boundaries when checked
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Horizontal cutting Allow toolpaths to be rotated out of the horizontal X-Y plane when checked.
This option is only applicable if using a machine that is capable of cutting
toolpaths notin the X-Y plane.

Show Lift Options Lift Opfions
Enable Tool Com- Enable the tool compensation option in the cut parameters dialog.
pensation
Misc
Bump Increment The distance a selected object is moved when the arrow key is pressed by
default. Pressing Shift + Arrow Key will vary the bump increment based on the
zoom level so when zoomed in close, objects move smallerincrements.
Click Increment The amount that values change when adjustment arrows are clicked in dia-
logue boxes.
Snap Threshold The distance in pixels at which the snaps take effect and the cursor auto-
matically moves to the snapped geometry
Initialization
Maximize Application Automatically maximize the software on start up
Maximize Document Automatically maximize new documents when opened
Display 4 Views Display the 4 view mode by default
Prompt for Plate Open the define plate dialogue when creating a new design
Small Part Size Threshold Used by EnRoute to select small parts when output small parts first is selected
Solutions Path Defines the path of any 3rd party applications
Display

Display preferences define the colors for each of the drawing elements and set the rendering options.

Color Selection
»  Double click the color you want to change
»  Select the desired color from the pop up window

»  Click OK to save the changes

Display Seftings
Show Layer Colors Show colors assigned to individual layers
Update Buttons When checked, toolbar buttons will automatically disable when the function

is not available. This option should typically be enabled
Real-time Rendered Pan-  Allow real time relief rendering while panning and rotating. If this causes com-

ning puter performance issues, it can be disabled in an EnRoute preferences file.
Contact EnRoute support for assistance
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Lift Options.htm

Rendering Options

Define what level of rendering to use in the perspective view.

OpenGLl Level 3 Highest level graphics rendering, the default setting
OpenGl Level 2 Default option in EnRoute 4
OpenGl Level 1 This option has been proven to work well on computers without dedicated

graphics cards

Windows Graphics Decreased performance to allow rendering on computers that cannot sup-
port OpenGL rendering

Units

Allows the drawing units for length, time, and speed to be selected.

If the units are changed while a drawing is open, the size of any existing objects will be converted to the new units and
remain the same size.

Toolpath units are not automatically converted in open drawings. It isrecommended to close a drawing con-

taining foolpaths, change units, and reopen the drawing to ensure the toolpath units are converted correctly.

Grid

Define the grid size used in the drawing window. There are two levels of grid, Major and Minor. Each level has the same
set of parameters.

Show Grid When checked, the grid is displayed in the workspace
Interval Distance between grid lines
Style Style of the grid lines
Size Size of the grid lines in pixels
Color Color of the gridlines
View Setup
Standard Items
Plate Display the plate when checked
Contours Display contours when checked. Contours are the main type of drawing element, this

option is usually left enabled

Contour loops Display contour loop indicators when checked. The indicators will display before gen-
erating toolpaths. EnRoute will automatically remove loops when generating toolpaths
by altering the contour.

Open Contour dir- Display arrows on open contours indicating their direction
ection

Popup menu on right Open a popup menu on a right click in the workspace when checked
click
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Toolpath Items

Toolpaths Display toolpaths

Direction Display direction arrows on toolpaths

Entry/Exit Display the Entry and Exit positions for each toolpath
Bridges Display the location of toolpath bridges

Start Point Display a small circle with an X inside to indicate the toolpath starting point

Toolpath Width

Determine how toolpaths are displayed
Lines Displays toolpaths as lines with directional arrows.

By Tool Displays toolpaths with the diameter of the tool used to create the toolpath.

Toggle between the two modes using the F9 key.

Depth

Controls how toolpaths are displayed based on depth
All Depths All toolpath depths are displayed
Surface Toolpaths at the surface are displayed
Final The last (bottom) toolpath is displayed

[Specific Depth] One of the specific depths assigned to the passes is displayed

Tools

Control which toolpaths are displayed based on the associated tool. Options are displayed based on the tools used in
the drawing.

All Tools Toolpaths for all tool types are displayed

[Specific Type] Only toolpaths which use the selected tool are shown

Relief

Toolpath Tolerance

Define how closely toolpaths follow a relief surface. A smaller tolerance willmore closely follow the relief surface, but it
will also create more segmentsin the toolpath and increase the output file size.

Relief Lighting
Adjust the lighting posifion of rendered releifs.
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Start Point

Adjust where start points are automatically located for routing offset toolpaths

Long Edge Locate the start point at the start of the longest edge of the contour. If Edge Midpoint is
checked, the start point will be placed at the midpoint of the longest segment.

Direction Define a direction used to locate the starting point. The direction is defined in degrees
relative to the drawing origin.

Magnetic Enter a specific point and the start points will automatically be placed as close to the
defined point as possible.

Longest Segment Locate the start point at the start of the longest segment of the contour. If Segment Mid-
point is checked, the start point will be placed at the midpoint of the longest segment.

Dimension

Define the display parameters for all dimension tools.

Text height in the dimension tool

Define the separation distance between dimension extension lines and the contour sur-
face

Define the height of the arrow

Define the width of the arrow

Set the number of decimal places when measuring a line segment

1 W [ B

o
-
N
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Order

Set the number of decimal places when measuring an angle

Sets the position of text above the arrow line

Sets the position of text in the middle of the arrow line

Sets the position of text below the arrow line
e—> g

Define the default ordering process when generating toolpaths. The intferface matches the ordering parameters used in
Output, 2D simulate, Ortho Simulate, and Rendering. The order preferences can be updated from any of these tools.

Priority Order

Tool Order
Strategy Order
Object Order

Small Parts First

Maintain Grouping
Add Tool

Delete Tool

Clear Tools

Reset Active

Reset Parameters

Sort toolpaths based on priority. Priority order can be adjusted by clicking and dragging
the row headers. Reference the machine output section for more detail.

Add tools from the tool library and click and drag them into the preferred cut order.
Arrange EnRoutestrategy types into a preferred cut order.
Select the default object ordering method.

When checked, parts with surface areas below the defined threshold will be put at the
top of the object order list, regardless of other object ordering methods.

Grouped objects will be treated as single objects for object ordering.
Add a tool to the tool order list.

Remove a tool from the tool order list.

Clear all tools from the tool order list.

Resets currently active parameters to the default values.

Resets all ordering parameters to the default values.
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Create A Drawing

N

All EnRoute designs start with creating a new drawing. Select the new file button from the file toolbar or from the main
menu, File > New.

Drawing Files

All EnRoute designs begin with creating a new file or loading an existing design.

Create New Drawing

Il

Creates a blank drawing in the EnRoute workspace.

If another drawing is open when a new drawing is created, the new drawing becomes active and the existing

drawing is minimized. All open drawings can be switched between using the Window menu.

Open an Existing Drawing

=

Afile dialogis opened to select EnRoute files. When afile is selected, a preview of the EnRoute workspace is shown on
the right side of the dialog.

Save Drawing

If saving a file for the first time, or Save As was selected, the save dialogue box s displayed to enter a name

and location for the file.

Import Design

1. Activate the Import command

2. Selectthe file format and file location to import

3. Click Open

EnRoute User Manual - Page 24



See Preferences forimport options

Bitmaps must be converted to contours before generating toolpaths, see

Export Design
1. Fromthe File menu, select Export to open the export dialogue
2. Select afile format and file location
3. Setafilename
4

Click Save

Print

S

1. Activate the Print coommand

2. Select a print option

Design Print all contours in the current design
Selection Print only the selected contours
Window Print only what is displayed on screen
Plate Print only the plate

3. ClickOK

Plate Definition

A

The plate in EnRoute is a useful drawing aid that is commonly used to define the size of the material that will be cut. When
anew drawing is created, the plate definition dialog will be opened by default to define the plate size. This behavior can
be disabled in the Inifialization Preferences.

Parameters
Width Plate dimension along the X axis
Height Plate dimension along the Y axis
Thickness Plate dimension along the Z axis
X/Y Origin The position of the lower left corner of the plate
X/Y Margin If entered, a second dashed rectangle will be generated within the plate with the specified
margins. Typically used for masking out clamp locations.
Surface Option Choose to set the plate surface at the top of the material or bottom of the material (top of

the table).
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Wrap Plate EnRoute supports output for rotary access CNC machines. Enabling Wrap plate will auto-
matically set the plate size in the X or Y direction so it is compatible with the design being
wrapped. The wrapped dimension of the plate is the circumference of the wrapped sur-
face, which corresponds to the thickness of the material, which for a wrapped surface is
the radius of the material.

Material Select the type of material being used. Materials are defined in the material library.

Save Save the current plate parameters as a template. The template can be loaded when defin-
ing another plate from the template box.

Delete Delete the currently selected template.
Fit Design Automatically adjust the height and width of the plate to fit the current design.
Fit Selection Automatically adjust the height and width of the plate to fit the currently selected contours.

Create Plate from Contour

4

Define a plate with any shape. Select any closed contour and activate the Create Plate from Contour command.

This tool is useful when used with the remnant contour created by the nesting tool, automatically defining the next plate
as the remnant sheet from the last cut.

O

Plate Panels

=

Define an area within a panel to generate output for toolpaths. This tool is most useful for breaking up large designs that
can be cutin smaller pieces.

Define a basic plate, it should be the size of the design to cut.

bl Ll

2. Activate the plate panels command, a wide yellow border will appear within the plate boundary.
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3. Click outside the plate border and drag to the location within the panel fo create the plate. Hit Enter fo apply.
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Use the F2 button to open a precision dialogue window to precisely place the panel border. Click

OK to apply.

4. The shaded areais the active area to generate toolpaths, any toolpaths that cross the boundary will be cut off
when output.

5. Toswitch active panels, activate the plate panels command and click on a different panel. Press Enter, or open
the F2 menu and click OK to apply the change.
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Plate Templates
Templates can be used to save plate settings that can be used across multiple designs.
Create Template
1. Entferparametersin the Plate Definition dialogue
2. Enteratemplate name in the Template box
3. ClickSave to add the template to the library
Using a Template
1. Open the Plate Definition dialogue
2. Click onthe Template drop down box

3. Selectthe template from the list fo load the saved parameters
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Creating Contours

Draw new contours that will become the basis for a new design.

Line

/

Draws a straight line segment connecting two points

1. Activate the draw line command

2. Click at the desired starting point

You can also enter each starting and ending point’s coordinates into the Precision Input Center. Enter

each point's coordinates into the X, Y and Z fields and click OK.

3. Move the cursor to the end point and then click again

Hold the SHIFT key down while drawing to snap the current line segment to horizontal or vertical only.

4. The end point of the first segment becomes the start point of the next line segment, repeat the process to create
several line segments

5. Right click once to cancel the next segment, right click again to exit the draw line command

Polyarc

)

Create aseries of lines and arcs to form a new contour.

Create segments one at a time using the drawing modes fo modify each segment individually.
1. Activate the Polyarc command to automatically open the precision toolbar
2. Selectline or arc mode in the precision toolbar

3. Select creation mode based on the desired drawing mode

Creation Mode options will only be available when available based on the arc or line creation mode. Arc cre-
ation modes cannot be used when drawing a line.

This fool can only be used in the top view. Arcs are limited in EnRoute to the X-Y plane.

Creation Modes

Line Toggles line segment creation mode
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Arc Toggles arc segment creation mode

Position Define the X'Y coordinates for the next point in the segment
Direction Define the angle for a line being created. Define the angle of the tangent line for an arc being cre-
ated.

Only available in arc mode:

Arc Center Define the arc center
Radius Define the arc radius

Sweep Angle Define the arc sweep angle

Bezier Curve

~

Bezier curves provide a way of drawing complex curved segments. Each section of a Bezier curve is defined by four
points, two end points, and two handle points which define the shape of the curve.

@

The Bezier tool will draw multiple segments linked together. Each segment can either be drawn as a Bezier segment or a
straight line.

All of the segments in a contour created with the Bezier tool are Bezier sesgments, even if they are drawn as
straight line segments. In the case of a straight line sesgment, the handles for that segment are located at the
end points of the segment.
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Drawing a Line Segment

1.
2.
3.

Activate the Bezier command
Click af the desired starting point

Click at the desired end point to complete the line segment. The end point becomes the start of a new line seg-
ment

Drawing a Bezier Segment

1.
2.
3.

Activate the Bezier command
Click at the desired starting point and drag the mouse to create a Bezier handle and create a curve

Click the mouse again to end the curve. Drag the mouse to begin another Bezier segment, release to start aline
segment

Bezier curves cannoft be created with the Precision input center, the curves must be created with a mouse or

other pointing device

Sketch

e

Create contours by drawing freehand

> 0w

&\

Activate the Sketch command
Click and hold the left mouse button fo begin drawing
Move the mouse fo create the confour shape

Release the left mouse button to end the contour, EnRoute will construct the drawn contour from line and curve
segments

Right click fo exit the tool
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Rectangle

[]

Createrectangles by drawing or defining parameters

Drawing a Rectangle by Corners

J

1. Activate the rectangle command

In the precision toolbar, select Draw from Corner to Corner

Click the left mouse button to define the first corner

M wn

Move the mouse button and left click again to define the second corner and complete the rectangle

Hold the SHIFT key to only draw squares

5. Repeatsteps 3 and 4 to create more rectangles

6. Right click fo exit the tool

Draw Rectangle by Dimensions

[=]

1. Activate the rectangle command

2. Inthe precision toolbar, select Draw by Dimensions

3. Enferthe Height and Width values into the precision toolbar to define the rectangle size

4. Clickthereference grid button to select the corner, side, or center point that will be used to position the rect-
angle

5. Leftclickin the workspace or click apply to create arectangle

6. Repeatto create more rectangles orright click to exit the tool

Radius Corners, Chamfer Corners, or Inverse Radius Corners

S

EnRoute User Manual - Page 33



N / \ /

1. When drawing arectangle, select a corner effect in the precision toolbar

2. Define the size of the effect to be applied

The selected corner option will only be created if the height and width of the rectangle are large

enough fo allow the size of the effect defined

3. Newly drawnrectangles willhave corner effect applied

Circle

C

Draw a circle by defining different parameters.

Drawing a Circle by Center and Radius

<

1. Activate the circle command

In the precision toolbar, select By Center and Radius

Define the radius value in the precision toolbar

M 0D

Left click fo place the circle in the workspace. A more accurate position can be defined by entering coordin-
atesin the precision toolbar

5. Left click to create more circles with the same radius orright click to exit the circle tool
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Drawing a Circle by Center and Point

4.
5.

Activate the circle command
In the precision toolbar, select Circle by Center and Point

Left click fo place the center point of the circle

Snaps are a good way fto locate the center of circles

Move the mouse away from the center point and left click again fo define a point on the circle

Repeat steps 3 and 4 to create more circles, orright click to exit the circle tool

Drawing a Circle by Three Points

O

1.

2
3.
4
5

Activate the circle command

In the precision toolbar, select By Three Points

Left click fo define the first point on the circle, then again to define the second.

Click afinaltime to define the third point, and the circle will be create that contacts all 3 points

Repeat steps 3 and 4 to create more circles, orright click to exit the circle tool

Drawing a Circle by Corners

@)

o > 0N

Arc

A

Activate the circle command

In the precision toolbar, select Circle By Corners

Left click to place the first corner

Move the mouse and left click fo define the other corner and create the circle

Repeat steps 3 and 4 to create more circles, orright click to exit the circle tool

All Circles can be drawn by entering relevant information into the precision toolbar, or by drawing in the work-
space

Three methods to create arcs
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Drawing an Arc by Center, Start and Finish

8|

S T o

Activate the Arc Command

In the precision toolbar, select Arc by Center, Start and Finish
Left click fo define the arc center

Move the mouse and left click again to define the start point
Click again to define the arc end point

Right click to exit the arc tool

Drawing an Arc by Cenfer, Radius and Angle

Iee!

1.

2
3
4.
5

Activate the Arc Command

In the precision toolbar, select Arc by Center, Radius and Angle

Define the arc radius and sweep angle in the precision toolbar

Define the arc centerin the precision toolbar and click APPLY to create the arc

Repeat to create more arcs, orright click to exit the fool

Drawing an Arc by Three Points

'

Activate the Arc Command

2. Inthe precision toolbar, select Arc by Three Points

3. Leftclickto define the arc start point

4. Click again to define the end point

5. Click afinaltime to define a point along the arc

6. Repeatsteps 3-5to create more arcs, orright click to exit the fool
Ellipse

@)

Three methods to create an ellipse in the workspace

Drawing an Ellipse by Height and Width

&
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1. Activate the ellipse command

From the precision toolbar select Draw by Height and Width

Define Height and Width parametersin the precision toolbar

Define the centfer point position in the precision toolbar and select APPLY to create the arc

Left clickin the workspace to create more ellipses with the same parameters

S T

Right click to exit the arc tool

Drawing an Ellipse by Major and Minor Axis

i

1. Activate the ellipse command

From the precision toolbar select Ellipse by Major and Minor Axis
Left click to place the center of the ellipse

Move the mouse to define the angle of the first axis

Left click fo define the width of the ellipse along the first axis

Repeat steps 4 and 5 for the second axis to complete the ellipse

A o S

To create more ellipses with the same dimensions, switch to Draw by Height and Widthand left click to create
another ellipse

Drawing an Ellipse by Corners

e

1. Activate the ellipse command

2. Fromthe precision toolbar select Draw from Corner to Corner

3. Leftclickto place the first corner

4. Move the mouse and left click again to define the opposite corner

5. Repeatto create more ellipses orright click to exit the tool
Polygon

%

Create multiple sided closed contours such as pentagons and stars.

Parameters

Create concave polygons

i Create convex polygons
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Mesh creation mode

f Contour creation mode

Points The number of external points to create in the polygon
Standard Select a standard star pattern to create

Radius (Outer) The radius for all exterior points along the contour

Radius (Inner)  The radius for all interior points along the contour

Center Define the coordinates for the polygon center

Height Define the mesh height

Return Height  Define a vertical offset between the mesh and the drawing plane

1. Activate the Polygon command
2. Define the desired parameters in the dialogue window

3. Leftclickinthe workspace to create a polygon or click Apply
Text

A

Create textin the workspace and modify parameters such as size, font, and spacing. The left side of the precision foolbar
will allow the font to be selected and display a preview of the selected font.

Parameters

Defines the height of created text objects. The height parameter is a multiplier
that adjusts the character height relative to the default width defined by the selec-
ted font. As the parameter is adjusted the cursor will change height to preview the
new text height.

Defines the slant of text characters. Positive values will cause the letter to lean
towards the right, negative values will lean the letter to the left.

Defines the width of the text characters. The width parameter is a multiplier that
adjusts the character width relative to the default width defined by the selected
font.

Define the spacing between characters. Positive values increase the spacing,
negative values decrease the spacing

Adjust the location of the selected text up or down. Positive values move text up,
negative values move text down.

b (36 (T B W
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Select the preferred text alignment. Left, Center, or Right justified.

E Toggle which side of a line or curve the text is created on.

Create Text

Activate the Add Text Command

2. Leftclickinthe workspace to place the cursor. To create text on an arc or curve, left click the contour at the start-
ing point for the text.

3. Selectthe text style, a preview will be shown to the right of the font selection.

4. Type textto createitin the workspace.

5. Select the Close button to exit.

Edit Existing Text

1. Allof the text creation tools can be used to edit text, start by activate the Add Text command .

2. Leftclick onthe text to be edited. The cursor will snap into place in line with the selected text.

3. Clickand drag across charactersin the text to select them. A box will appear around each characterindicating
it has been selected.

4. Modify the text parametersin the foolbar to change the selected text.

5. Selectthe Close button fo exit.

Edit Text Character Spacing

\ |

E

Select the text fo be edited.
Activate the Edit Existing Text command .
Click on the text to be edited.

Colored points willappear to edit the text with.

an

5. The Green Point changes the starting point of the line, the Blue Point adjusts individual letter spacing, and the

Red Point equally adjusts the spacing of all letters.

Convert Text to Curves

A

Text objects must be converted fo curves before toolpaths can be generated.
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Any toolpath command will automatically convert text to curves, or you can use this tool to convert text to

curves.

1. Select the text objects to be converted.
2. Activate the convert text to curves command and the text will be converted immediately.

3. The text display colors will change from the fext object display color to the standard contour display colors.

Text Object Text Converted to Curves

Dimensions

Display measurements of lines and angles.

I — I Measure the distance between two points

|(} Measure the angle between two contours

@ Measure the radius of a contour
@ Measure the diameter of a contour

_I/ Draw a leader arrow in the workspace

Geometry Creation Wizards

iGN SRRl INS) RIS

Wizards in EnRoute provide a method to automatically create common objects rather than drawing them. Wizard para-
meters can be saved to make recreating the same objectsis easy.
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Boxster

Cone

Flange

Gusset

Helix

Lift Lug

Part Round

Quarter Round

Radius Rectangle

Thread Pitch

GCode

Configure and
generate stand-
ard cabinet
shapes using a
set of para-
meters to control
the geometry

Generate flat
geometry that
can be formed
into a cone

Parametrically
create flanges

Create gusset
geometry

Define the path
of a helix and the
position within
the workspace

Generate 2 dif-
ferent shapes of
lift lugs

Easily create par-
tial round geo-
metry

Define the dimen-
sions of a stand-
ard quarter

round geometry

Create rect-
angles with roun-
ded corners

Generate a
thread pitch path
by specifying
standard thread
dimensions

Import geometry
from GCode files
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Simple Box A box generator
@ wizard that
builds contours
to create a box
from a provided
set of para-
meters

Vectorize Bitmaps

¢

Bitmap artwork must be converted to vectors before it can be used to generate toolpaths. This fool traces bitmaps and
convertsit to vectors. There are 3 modes for vectorizing bitmap images, Standard, Centerline, and Color Vectorize.

For the best results, clean up bitmaps before vectorizing by removing speckling and unwanted detail. For

standard vectorizing, the best results are achieved with black and white or gray scale images.

Common Parameters

The common parameters apply to the Standard and Centerline vectorizer.

Bezier Favor the creation of bezier segments when approximating the bitmap

Enhanced Corners Create a contour with distinct corners where possible

Enhanced Curves Favor the creation of arc segments when approximating the bitmap

Auto Cleanup Automatically simplify the created contours by reducing the number of segments
Tolerance Specify the smallest feature on the bitmap to keep when cleaning up the created con-

tours. A smaller tolerance will maintain more detail with a more complex contour, a lar-
ger tolerance will create a contour that is easier to edit by removing some of the detail.

Standard Vectorizer

The standard vectorizer will create contours from a bitmap image by tracing the boundaries between the primary 2 col-
orsin the image. This vectorizer mode works best with black and white and gray scale images.

Centerline Vectorizer

Pure Centerline When enabled, the vectorizer will only create the centerline trace

Outline Thick Areas When enabled, the vectorizer will outline areas of the bitmap wider than the
specified value

Min Segment Length The minimum contour segment length to create

Min Centerline Section The minimum length of a centerline section to vectorize
Automatic Width Automatically recognize thick areas to outline

Line Width Define the minimum width to begin outlining the bitmap
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The cenferline vectorizer will race a single line down the middle of a bitmap section. The centerline vectorizer will also
outline areas of the bitmap that are thicker than a specified width.

Only black and white images can be vectorized using the centerline tool.

Color Vectorizer

Max Colors The maximum number of colors the vectorizer will recognize and convert to contours. A lower
value will create simpler contours, and a larger value will create more complex contours.

The color vectorizer will create contours that represent distinct colors in the bitmap being vectorized. For simpler bitmaps
that have alimited number of colors, setting the maximum colors value close to or slightly below the number of colorsin
the bitmap will yield the best results. For more compleximages getting the desired result will likely require vectorizing the
image a few times and adjusting the Max Colors value to get the desired contfours.
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Arranging Contours

Adjust how contours are positioned within the workspace.

Selecting Contours

Select a contour by clicking anywhere along the edge. Multiple contours can be selected by any of the following meth-
ods:

”  Hold the Shift key and click each contour

»”  Click and drag a selection box around the contours

Dragging from the top of the workspace down will select all contours fully enclosed by the selection

box. Dragging from the bottom up will select any contours the selection box touches.

»”  Select Edit > Select All from the menu to select all contours in the design

Automatic Sorting

When multiple contours are selected, EnRoute automatically identifies and color codes each contour as open curves,
containers, or holes. By default, all closed contours are classified as containers. If a closed contouris completely con-
tained within another closed contour, the inside contour becomes a hole within the outer container and forms an inner
edge to the bounding container.

By default, selected contours will display blue for containers, red for holes, and purple for open curves.

The images below illustrate the selection of 2 contours, the outer contour classified as a container and the inner contour
classified as a hole, and the result when a hatch fillis applied.

- m>

Cut, Copy, and Paste

Contours can be manipulated using the cut, copied, and paste commands fo move between drawings and layers.

Cutand Paste
1. Selectthe contour and choose Edit > Cut from the menu, or press Chrl + X.
2. Selectwhere to place the contour.

3. Choose Edit > Paste from the menu or press Chrl + V.

Copy and Paste
1. Selectthe contour and choose Edit > Copy from the menu, or press Chrl + C.
2. Selectwhere to place the contour.

3. Choose Edit > Paste from the menu or press Chrl + V.
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When pasting info the same design, the copy will be placed in the same position as the original

To create a copy in the same design, press the Ctrl key and click the center control box of the contour and
drag a new copy to a new location.

Pasting from Other Programs

See General Preferences for contour merge settings when pasting from other programs.

Grouping Contours

@@

Contours can be grouped together so that all contained contours can be manipulated as a single contour.

1. Select anumber of contours

©

a. Selecting any one of the contours in the group will select the entire group.

2. Clickthe Groupicon or press Ctrl + G to group them together

B- - -z - - -

23
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b. When the groupisre sized or moved within the workspace, itis freated as a single contour.
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3. Toseparate the group, select the Ungroup Icon Ci or press Ctrl + U
Interactive Adjustment

Several tools are provided to accurately position and size objects in EnRoute.

With the Mouse

Objectsin the workspace can be moved interactively using the mouse. To move a selection, click on any of the contours
in the selection and then drag to the new location. Itisimportant to click on the confour fo maintain the selection, as
shownin the image below.

o [% -------------- &

Contours can be moved using the nine selection handles around the selection box. The center handle will always move
the selection when clicked and dragged around the workspace. Clicking on any of the other handles will scale the size

of the selection, but if the cursoris placed near the selection handle and dragged, the selection will snap to the handle

for accurate placement. The images below illustrate the cursor placement.
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Scale Contour Move Contour

Note that the center of the cursor changes to a black dot when in scaling contours, and is white when moving

contours.

Contours can be scaled interactively by clicking any of the selection handles around the perimeter of the selection box
and dragging. Hold the SHIFT key while dragging to scale the selection proportionally.

Precise Adjustment

The Precision Input Center can be activated by pressing the F2 key and provides aninterface to precisely adjust objects.
There are 3 tabs in the precision input center: Scale, Rotate, and Move.

Scaling the selection can be accomplished in the Scale Tab by entering the dimensions or a scaling factor. Check the
Proportional option to scale the selection proportionally.

Torotate aselection from the Rotate Tab, the axis of rotation must be defined. To rotate in the Top view, the contour will
rotate about the Z axis in the X-Y plane. By default the center of rotation is the center of the selection, but that can be
changed by entering new coordinates for the rotation center. Enter the desired rotation angle and click OK to complete
the rotation.

Move a contour through the Move Tab by defining the corner of the selection to define the position for, and then enter-
ing the coordinates for that location. Click OK fo move the selection.

The include toolpaths option specifies if toolpaths are moved and sized along with the contours.

Move, Scale, and Rotate Tools

There are also tools to Move, Scale, and Rotate objects that can be activated from the toolbar.
» Move
» scdle

» Rotate
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Move
O

o

Move selected objects through one of 3 modes.

Right Click at any point when using the Move tool to back up one step in the Move dialogue. For example

when interactively selecting the starting point, right click fo reset the start point and reselect with the mouse.

Move Absolute

ED

Define astarting and ending point for the move. Starting and ending points can be defined by entering the coordinates
or by clicking in the workspace. With snaps enabled, shapes can be accurately positioned interactively using the
mouse.

Start Coordinate of the starting position of the selection

End Coordinate of the ending position of the selection

Move Relative

B4

o
Define a starting point and the amount to move in each direction.
Origin Coordinate of the starting position of the selection
Move The amount to move the selection in each direction
Move Corner

rr

v

Move a corner of the selection to a specific coordinate.

End Coordinate of the ending position of the selection

Corner Selector Choose which corner to move to the end point

The Copy option can be checked for any move mode to create a copy of the selection and move it to the
specified location
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Scale aselectionin 3, 2, or 1 dimensions interactively or by specifying the final dimensions.

Three Dimensions

e

Scale the selectionin all 3 dimensions, regardless of the active view.

Two Dimensions

| I

Only the 2 visible dimensions will be scaled. In the Top view only the X and Y dimensions will be scaled. This is useful when
scalingreliefs fo keep the thickness constant.

One Dimension

=

Distort the selection by scaling along a single axis by clicking and dragging interactively. Click to define the starting and
ending point of aline to define the direction to scale the selection. Move the mouse along the axis to distort the selection
and click again fo apply the changes.

Parameters
Size Scale the selection by entering the XYZ sizes
Factor Scale the selection by applying a scaling factor

Include Toolpaths Scale any toolpaths in the selection
Proportional If checked, the scaling operation will be applied proportionally
Copy Create a copy of the selection when scaled. The original will remain in the same position

Corner Selector Select which point remains stationary when scaling the selection

Rotate

[~
—

Rotate selected objects about a selected point by defining the angle of rotation.

Right Click at any point when using the Rotate fool to back up one step in the Rofate dialogue when rotating

interactively

Parameters
Center Specify the coordinates for the center of rotation
Axis Define which axis the selection will be rotated about. To rotate objects in the Top view,

objects will rotate about the Z axis.

EnRoute User Manual - Page 49



Angle The angle of rotation
Copy If checked, a copy of the selection will be created and rotated

Corner Selector Select the rotation center when using the Angle parameter

Hold Shiff when rotating interactively with the mouse to snap the rotation angle to fixed increments

Mirror

PN

Reverse the selected contour so that it becomes its mirrorimage. A copy of the original can be created by checking the
copy option.

Mirror Interactively

N

Click to place the start point of the mirror axis, and then click again to place the end point. The start and end point can
also be defined by entering the coordinates. A preview will display while working.

B----45;

-
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Mirror Vertically

i

Mirror the selected contour about the vertical axis. Click the selection grid button to select the point the confour will be
mirrored about.

. = i
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Mirror Horizontally

Mirror the selected contour about the horizontal axis. Click the selection grid button to select the point the contour will

be mirrored about.

Align Contours

Align one or more EnRoute objectsrelative fo each other

Align to Centers

Align to Bottom

Align to Top

Align to Center Vertically

<0

[ 3
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Align to Center Horizontally O— — u*?
=L O

I

Alight Left - o ui\\(_:.
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Align Right O— g ESAA(:

Nest

™M

Arrange parts on the plate to maximize material ufilization. There are 2 different nesting dialogues that can be accessed
from the Nest tool: the Shape Nester, and the Block Nester.

Common Nesting Parameters

Quantity The number of copies of the selected parts to create and nest. An individuall
quantity can be applied to each part by selecting each part and changing the
quantity before clicking apply.

Priority Order The priority for each object to be nested used to determine the nesting order.

Gap Minimum distance between each contour being nested.

Margin Minimum distance between the edge of the plate and the contours being nes-
ted.

Multiple Sheets When checked, additional layers will be created to allow for the nesting of all

objects. After nesting objects, alllayers will be turned on, click the layer arrows to
cycle through nested layers.

Create Remnant When checked, create a contour that represents the remnant of the material
used to cut the objects. The remnant can be created and a new plate can be
created. See Create Plate from Confour

Create Summary A summary report will be generated when checked. The report can be accessed

=

by using the View Summary tool

Shape Nester Dialogue
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Shape Nester Types

Standard

The base nester that has been the standard since EnRoute version 4.
New

The New nesteris capable of recognizing contours within plate boundaries as obstructions and will nest around them
providing a simple way to avoid clamps or a section of the material with defects.

Legacy
The original nester in early versions of EnRoute.

Shape Nester Parameters

Nest Originals When checked, the original objects will be nested. When additional quantities are
defined, the originals will be highlighted when nested.

Step Angle Specify the angle in degrees objects are allowed to rotate by when nesting
Use Holes When checked, smaller contours will be nested inside the holes of larger contours

Obstruct (New When checked, contours within the boundaries of the plate will be recognized as

Nester Only) obstructions. Contours will be nested around obsfructions. Obsfructions must be selected
with the contours to be nested before activating the Nest tool. Obstruction contours will
be displayedinred.

L ul

Reference Click the position of the plate to nest the contours in. The New nester allows multiple loc-
Grid afions to be selected.

Block Nester Dialogue
all
=

Designed to nest squares and rectangles efficiently and provide tools to align contours for optimized cutting.

Block Nester Parameters

Allow Rotate When checked, selected contours can be rotated when nested.
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Create Common Line When checked, the block nester will generate a common line contour that can be
used fo generate toolpaths. The common line contour prevents double cutting
rectangular parts. See the example below.

Common Line Example

Using the block nester, the parts pictured below were nested and the common line was created using the following
parameters:

Quantity 2
Gap 0.25"
Margin 0.25"
Create Common Line Checked

The gapis set to 0.25"because a 1/4" tool will be used to cut the parts

To cut the parts, a toolpath must be generated from the common line contour. Select the common line contour.
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Activate the Open Contour Offset tool \ .Selecta 1/4" end mill tool, and from the strategy parameters section,
select the follow Middle of contour option. Click OK fo apply the toolpaths.
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By assigning the gap distance the same with as the tool, both sides of adjacent parts can be cut at the same fime.

Dynamic Nest

0T
Click and drag parts onto the plate to nest them. The parts will automatically rotate to fit within the constraints of the
other objects within the plate and the plate boundaries.

Parameters
Rotation Steps The maximum number of rotations EnRoute is allowed to attempt before placing an
object
Nest Resolution Increase the display resolution of the nested object. Increased resolution will decrease
the display speed
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Part Offset The minimum distance between each nested contour

Plate Margin The minimum distance between the plate edge and nested contours
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Editing Contours

Manipulate contours into new shapes or fine fune the placement of points and segments.

Edit Points

NS

Edit Points Video

Manipulate the points, lines, and curves within contours. After activating the Edit Points tool, select a contour to edits the
poinfs and segments.

Click and drag points to change the starting and ending points of segments. Click and drag the segment to change the
path of the segment.

Clicking and dragging a line segment will automatically convert it to an arc.

Cursor

Hover over asegment to preview ifitis aline, arc, or curve.

Line Arc Curve
VY ™
Convert Segments

Right click on a segment to open a menu with commands specific fo that segment.
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Convert to Line Convert segment to a line
Convert to Arc Convert segment to an arc

Convert to Curve Convert segment to a curve

Click and drag to select multiple segments at once. Once selected, the segments can be moved or con-
verted together.

Linearize

7

Convert a section of a contour to aline by defining a starting and an ending point.

1. Activate the Linearize command

2. Clickto place the first point on the contour
3. Clickto place the second point on the contour
4. A preview of the line will be shown in pink, drag the start and end points to adjust placement
5. Press Enter to accept the change
Insert Corner

r

Select 2 points on a contfour to extend tangent lines from fo form a corner.
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1. Activate the Corner command

2. Click to select the first point
3. Clicktoselect the second point
4. A preview of the corner will be shown in pink. Drag the two points to adjust how the corner position.
5. Press Enter to accept the change.
Curve Fit

7

Replace asection of a confour between 2 points by fitting a curve to the contour path.

ATNAN

1. Activate the Curve Fit command.

Click to place the first point

Click to place the second point

> 0D

A pink preview of the new segment will appear. Drag the two points fo change the contour section that will be
approximated.

5. Press Enter to accept the change

Noise Distortion

7O
O

Distort contours by infroducing a random noise pattern. Control the size of the distortion through input parameters.

The images below show a set of confours before and after infroducing noise distortion
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Noise|Noise

The distort fool can modify contours orreliefs. Distorting a relief creates a different effect than creating arelief from a dis-
forted contour asiillustrated below.

JC0

The farleft contouris the original, and the right contour has been distorted. The left relief was created by applying a
beveledrelief to the distorted contour. The right relief was created by applying a beveled relief o the base contour and
then adding noise distortion.

Another example shows how the original relief on the left can be modified with a subtle texture to create a unique sur-
face.

Method 1
1{

Define parameters that control the size and position of the noise.

Wavelength Define the length along the contour over which the noise is applied along the contour.
Longer values spread the distortion over longer distances.

Jitter Define the strength of the distortion. Small values cause subtle distortions, larger values
exaggerate the distortion.

Horizontal The distance the contour is distorted in the horizontal (X-Y) plane
Amplitude
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Vertical Amplitude The distance the contour is distorted in the Z axis. To keep contours flat vertically, set this
value to 0.

Method 2
2]

Method 2 provides more parameters than Method 1 and allows the noise to be controlled in each direction individually.
There are two parameters, Size and Power, and there are two instances of each parameter. The confouris distorted in
two passes, and each set of parameters conftrols one of the distortion passes.

Size Define the size of the distortion in the X, Y, and Z direction. Distortion can be limited in any direction by
setting the value to 0

Power Define the strength of the distortion in each direction. Small values create subtle distortions, larger val-
ues create more exaggerated distortions.

Extend

7

Automatically extend an open contour to the next intersection point.

4 N

1. Activate the Extend command
2. Hoveroverthe end of an open contour, a pink preview of the extension will be shown

3. Leftclickto apply the change

To interactively extend an open contour, hold Shift and hover over the open end of the contour to extend.

Move the mouse fo the new end point and click again to extend the contour.
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Trim

X

Trim open contours that extend beyond intersection points with other contours.

1. Activate the Trim command

2. Hoveroverthe segment fo frim, a pink preview will show the frimmed segment

3. Clickto trim the contour

Contours can be tfrimmed interactively by holding Shift and hovering over the open end of the confour. Move

the mouse along the contour and click to trim the contour.

Cut By Line

Cut closed contoursinto multiple closed contours.
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1. Left click to define the cut line starting point
2. Leftclick again to define the second point of the cut line
3. Any contours that crossed the cut path are divided into separate contours along the cut line

Cut by Line affects contours differently when used on multiple selected contours. When groups of contours are selected,
they are automatically grouped into containers and holes. The grouping is respected by the Cut by Line tool. The fol-
lowing images illustrate this concept. When 2 contours are cut without selecting them, 4 contours are created. When the
contours are selected before cutting, the hole is respected and 2 contours are created.

3

EnRoute User Manual - Page 64



Weld Confours

Combine multiple overlapping contours through different weld operations.

Weld Joined

Overlapping areas are merged together to form a contfour that is the union of all of the parts.

Weld Common

&

Only the overlapping sections between contours are merged info a single contour.

Weld Subtract

7
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The volume of a number of contoursisremoved from the first contour selected. The resulting contour is the first contour
minus any area that overlapped with other contours.

Weld Jigsaw

S

Create contours based on the intfersections of contours in the design.

The Jigsaw tool works with both open and closed contours which can be helpful when constructing closed

contours for toolpathing.

Move the cursor over the design and possible contours will be highlighted automatically.
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When the desired shape is highlighted, click and drag to create the new contour. Release to place the confourin the
design.
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The Jigsaw tool works in the XY plane and can apply to contours at different Z heights. All contours are pro-
jected to the XY plane and the resulting contours are created within the XY plane at a Z height of 0.

Fillet

=

Insert an arc in the selected corners of one or more contours.

Parameters

Single Fillet Select a specific corner to fillet
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Multiple Fillet Choose which corners to fillet within a contour

Inside Corners

Outside Corners C[
All Corners <

Chamfer Apply a chamfer to corners instead of a fillet
Radius The radius size for the fillet or chamfer
Keep Original When checked, the original contour will not be modified and the fillet will be created as an

open contour over the original contour

Single Fillet
1. Activate the Fillet command
2. Clickto define a point on eitherside of the corner to fillet
3. Apreview of the fillet will appearin pink, drag the starting and ending point fo adjust the fillet
4. Click Apply to create the fillet

Multiple Fillet
1. Activate the Fillet command
2. Selectthe contour tofillet and the Multiple Corners option.
3. Thefillets will be previewed in pink
4. Click Apply to create thefillets

Where fillets overlap they will automatically be created tangent to each other
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Join

e

Join open contours together.

1. Activate the Join command

2. Click on the first contour end to join

3. Hoveroverthe second conftour end to join, ared preview will be shown of the new segment
4

Click again to join the contoursinto a single contour

The join tool can also be used to close gaps in open contours

Create a new contour offset from a selected contour.

Parameters
Number How many offset contours to create
Amount The distance between each offset
Outline Offset to the outside of the contour
Inline Offset to the inside of the contour
Rounded Create offsets with rounded corners
Square Create offsets with square corners
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Partial Offset

[m

Create an offset from a section of a selected contfour.

Select asegment of a contour to offset, hold the Shift key to select multiple segments

2. Specify the offset amount, and if the offset should have square orrounded corners
3. Clickto create the offset. Clicking outside of the contour will create an exterior offset, clicking to the inside cre-
ates aninterior offset
Merge Open Contours

¥

Join open contour ends within a definable tolerance.

> 0w

This feature is useful when importing drawings from other software packages that don't emphasize creating
closed contours. Quickly join tfogether separate contours into closed contours that can be used to generate

toolpaths

Select the open contours fo merge
Activate the Merge Open Contours command
Define the merge tolerance (the maximum distance between endpoints that will still be merged)

Click OK fo merge contfours

Explode Contours

b

Separate a closed contourinto individual segments.
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1. Selectthe contour to separate into individual segments

2. Activate the Explode Confours command to create individual segments

Convert Curves to Arcs

P

Transform curve and line segments within a selected contourinto arcs.

One curve may require many arcs to be converted properly, which canincrease the number of segments sig-
nificantly.

1. Selectthe contoursto convert

2. Activate the Convertf to Arcs command to convert the segments to arcs
Reverse Open Contours
\:l\

Reverse the direction of open contours. The direction isindicated by the arrow on the contfour.

The direction arrow display can be foggled in the under Open Contour Direction.

1. Selectthe open contour

2. Activate the Reverse Open Contour command to reverse the direction
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Multiple Copy

000
000
@00

Create multiple copies of a selected contour. Specify the number of copies and the orientation and pattern of the cop-

ies.

Array Copy

Create copies ordered into a specified number of rows and columns with a defined spacing.

Parameters

i
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As parameters are changed, a preview of the copies will be displayed in the workspace in pink.

Click Apply to create the copies.

Fill Plate Automatically fill the plate with as many copies that fit when checked. All other parameters will be
calculated automatically.

Rows Number of rows of copies to create

Columns Number of columns of copies to create

Horlz_ontal Define the horizontal spacing between each part
Spacing

Vertical Spa-
cing

i
oo

Define the horizontal spacing between the left edge of each part

=

EI Define the vertical spacing between each part
[ EI Define the vertical spacing between the top edge of each part
i |
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Arc Copy

Create copies spaced along an arc.

Parameters

As parameters are changed, a preview of the copies will be displayed in the workspace in pink.

Align Rotate the copies along the path of the arc

Number Number of copies to create

Radius Radius of the arc

Start Angle Angle in degrees for the starting point of the arc

Swept Angle Defines the distance the arc covers from the start angle to the end. Angles greater than 360

degrees will loop around
Center Specify the coordinates for the arc center
Panel Selector Select the corner, side, or center point to position the contours along the curve with
Click Apply to create the copies.

Path Copy

Create copies along another contour.
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Parameters

Align Rotate the copies along the path of the contour

Number Number of copies to create when Hold Number is enabled

Spacing Spacing of copies along the contour when Hold Spacing is selected

Offset % Offset the first copy from the starting point by a percentage of the spacing

Hold Number Specify a number of copies to be equally spaced along the contour

Hold Spacing Create copies along the contour at a specified spacing

All Corners Create copies at all corners of the selected contour

Inside Corners Create copies only at the inside corners of the selected contour

Outside Contours Create copies only at the outside corners of the selected contour

Panel Selector Select the corner, side, or center point to position the contours along the curve with

Click Apply to create the copies.

Patch Distort
/3

A
—

Distort selected objects using a grid of confrol points by moving the control points fogether or separately.

1. Select acontour orrelief and activate the patch distort command

2. Agrid willappear over the object.
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3. Click one or more selection points and drag to a new location

4. Click Enter to apply the change

T—

5. Right click to exit the tool
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Taper Distort

L
A

—

Distort an object by dragging the edges.

1. Selectacontour

Activate the Taper Distort command

2
3. Click on aselection handle and drag fo the desired position
4. Press Enterto acceptthe change

5

Right click to exit the tool
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Clean Up Contours

D

Automatically simplify contours by reducing the segment count while maintaining the geometry shape. Reducing seg-
ment count simplifies toolpath generation and reduces the chance for toolpath errors.

1. Selectthe contourto cleanup
2. Activate the Cleanup command

3. Setthe tolerance for the smallest features to keep

Higher tolerances will clean up the contour more, but will also change the appearance of the contour

more

4. Click OK
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Relief Tools

Reliefs are the basis of all 3D designs within EnRoute. EnRoute provides several fools to create relief surfaces and mesh
objects.

Revolve
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Extrude

—

Sweep Two Rails

Relief Dialogue

*

Many surface creation tools use a common dialogue window to define the relief.

Application Method

Define the relief creation mode and how it willinteract with existing reliefs.

Relief Options

Define how the height of the relief will be determined.

Relief Parameters

Additional parameters for adjusting the final height and shape of the relief.
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Relief Shape
Specify the relief shape.

Mesh Parameters

Mesh objects are constructed of friangles, or facets, that make up the surface. The number of facets to create the mesh
object with must be specified by defining the Stacks and Slices.

Stacks Number of sections along the revolution axis that the mesh surface is divided into
Slices Number if sections between the start and end angle per Stack
Stacks - The number of sections along the revolution axis that the mesh surface is divided into

Slices - The number of sections between the start and end angle per Stack.

Wizard Prompts

When the command is activated, the wizard will provide prompts for each step to complete. The wizard also provides
buttons to complete steps or cancel the tool.

“ Start Return to Start

4 Back Go back one step

» Next Go to the next step
v Execute Execute the function
X Cancel Cancel the function

Application Method

Define how the tool will modify the relief surface.
LEaEas

Add

a

Create araised relief. To modify an existing relief, select the base contour along with the modifying contours.
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The image shows an elliptical base relief with text relief applied using the add option.

Subtract

Create arecessedrelief. To modify an existing relief, select the base contour along with the modifying contours.
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The image above shows the text contours used to modify the base elliptical relief, and the resulting relief when com-
bined.

Merge Highest

The Merge Highest application method is most effective when modifying existing contours. When applied fo a new relief,
the resulting relief will be the same as the Add application method. When used to modify a relief, the existing relief is only
modified where the modifying relief is higher than the existing relief.
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The letter on top shows a new relief created by the Merge Highest application method. The bottom relief shows the res-
ulting relief when the same contouris used to modify an elliptical base relief.

Merge Lowest

The merge lowest option modifies an existing relief by merging the relief, only where the new relief is lower than the exist-
ingrelief.
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The top relief in the image above shows a new relief created with the merge lowest option. A flat surface is the lowest sur-
face over the entire areaq, so the resulting relief is flat. The bottom relief is the result of using the top contour to modify an
elliptical relief. Only the sections where the new relief surface is below the elliptical relief surface have been merged.

Replace

When used to modify an existing relief, the applied profile takes the place of the existing relief wherever they overlap.
When used to create a new relief, the result is the same as the Add application method.
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The top relief in the image is a new relief created with the Replace application method. The bottom relief shows the res-
ulting relief when the same contouris used to modify an elliptical relief.

Mesh

€

Some relief tools provide the option fo create a mesh objectinstead of arelief surface. The mesh option will appear as
the right most application method and activate a set of mesh definition parameters to define the mesh facet size.

Relief Options
Modify how relief shapes are created.
Normal

The default option. The height of the relief is defined by the width of the base contour and the specified relief angle. As
the contour surface becomes wider, the height of the created relief increases. Similarly, as the confour surface narrows,
the height of the relief decreases.
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Constant Height

Create arelief that has a constant specified height. The resulting relief has cleaner lines, most notably where relief parts
merge fogether.

o~

Scale to Height

Create arelief with the features of a Normal relief, and then scale it fo a specified height. The tool can be used to subtly
alter the relief shape by changing the relief angle. Increasing the angle will create a relief that looks more inflated, while

decreasing the angel will create a flatterrelief. In the images below the height of each reliefis the same, but the left relief
was created with arelief angle of 85 degrees, and the right relief used an angle of 15 degrees.

——”

Limit to Height

p—
p—
L=t

Create a normalrelief and cut off any relief surface above a specified height. Useful for creating reliefs that have aroun-
ded or beveled base with a flat top.
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Relief Parameters
Height

Define the height of created relief. This option is active for Constant Height, Scale to Height, and Limit to Height relief
options, andis automatically disabled when not applicable.

When the Normal option is selected, the relief height is defined by the angle parameter and height is not

needed.

Resolution

Define the resolution of a new relief in dots perinch (dpi).

Resolution units are in dots perinch regardless of the drawing units. If EnRoute is configured to use milimeters,
this parameter s still defined in dots perinch

Relief size and resolution is directly related to the amount of memory required. A relief with a resolution of 200 dpi will
require 4x as much memory as the same relief with a resolution of 100 dpi. To maximize performance, arelief should be
defined with the lowest resolution to accommodate the level of detail.
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Base

Define a vertical offset to raise the relief surface.

The image shows two applications of the same relief with a base dimension. The top relief was created with vertical sides
with the height of the base dimension. The bottom relief shows an elliptical relief modified with the same relief with a
base dimension.

Angle

Define Round and Beveled reliefs when the Normal relief option is selected. For beveled reliefs, the angle defines the
angle of the bevel. Forrounded reliefs, the angle defines the angle of aline fangent fo the round surface. An angle of 90
degrees will create arelief with a semi circular cross section.

In the image above, reliefs to the left were created with small angles, and the reliefs to the right were created with larger
angles.

Relief Shape

There are 3 basic shapes to create reliefs with.
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Round

Create a rounded surface using the selected contour as the boundaries.

(

a Create a relief with beveled edges that meet in the center of the base contour.

" Create a flat relief following the contour outline.

) -

Beveled

ﬁ

Flat

Revolve

¥

Use one or more contours to revolve around an axis o either modify a relief, or to create a new mesh object.
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In the image above, the left object is arelief modified by revolving a contour and the right object is a mesh created by
revolving the same contour.

Parameters

When the Revolve command is activated, the Relief Dialogue will activate with additional parameters to define the
revolve action.

Revolution Angles

Define the Start Angle and End Angle for the resulting relief or mesh. A complete revolution is 360 degrees and would
have a Start Angle of 0 and an End Angle of 360.

A half revolution would use a Start Angle of 0 and an End Angle of 180.

9

The image shows a mesh object created with a Start Angle of 45 degrees and an End Angle of 135 degrees.

Spin

®

Create arelief surface or mesh by spinning a contour around a selected axis.
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Parameters

When the spin command is activated, the Relief Dialogue will activate with additional spin parameters.

Spin Angles

Define the Start Angle and End Angle for the resulting relief or mesh. A complete revolution is 360 degrees and would
have a Start Angle of 0 and an End Angle of 360.

A half revolution would use a Start Angle of 0 and an End Angle of 180.

The image shows a mesh object created with a Start Angle of 45 degrees and an End Angle of 135 degrees.

The Start Angle and End Angle can also be changed interactively by clicking and dragging the circle used to define the
center of the spin as shown in the above image.

Height Control Curve

Define a confour used to vary the height of the relief as it is spun. This is an optional step in the spin wizard that allows for
more complex surfaces to be created. The relief on the left was created with a Height Control Curve. The relief on the
right was created using the same profile without the Height Control Curve.

Below are the confours used to create the surface above. The Height Control Curve is the top curve in green. The straight
line shown below itis the influence line, which is automatically drawn after the Height Control Curve is selected. Click
and drag the influence line to control how much influence the Height Control Curve will have on the spun surface. Drag-
ging the influence line away from the Height Control Curve will decrease the effect it has on the spun surface.
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Width Control Curve

The optional Width Control Curve modifies the spun surface the same way as the Height Control Curve, except it mod-
ifies the width of the spun surface instead of the height. The relief on the left was created using a Width Control Curve
and the relief on the right was created without it.

The optional Height and Width control curves can be used separately or together to create surfaces. The surfaces pic-
fured below were all created with the same profile, but with different options applied.

Both Height and Width Only Width Control Only Height Control Only the Profile
Control

Extrude
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Extrude one or more profiles along a path to create a mesh or modify arelief. The extrude tool also allows the size of the
profiles to change as they are extruded, and the ability to rotate the profiles while extruding.

Parameters

When the Extrude command is activated, the Relief Dialogue will activate with additional extrude parameters.

Scale and Rotate

Scale defines the proportion the profile size is to be changed by along the length of the contour. A Scale factor of 1.0 will
apply no scaling and the profile will be constant along the contour. A Scale factor of 0.5 willreduce the cross section by

half from the start to the end of the contour.

The image below shows a mesh created by extruding a circular cross section along an arc with a Scale factor of 0.25
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The Rotations parameter defines the number of fimes the profile will be rotated along the extrusion confour. A value of
1.0 will cause the profile to be rotated 360 degrees over the length of the extrusion.

The image below shows a mesh created by rotating a square cross section one time along the extrusion length.

Profile Placement

o
The profile placement buttons —i position the extruded profile relative to the path. Each button indicates where
the profile will be located as it is extruded.

The images below show examples of meshes created with the same profile and path, but using each of the profile place-

m[uls
00 —=——
m[u[=

Top View Right View

Sweep Two Rails

i

Use profile contours to either modify an existing relief or create a new mesh surface. Two open contours are specified as
rails for the left and right edges of section contours to follow as they are used to create an exfruded surface.

The image below demonstrates a surface created by sweeping a semi-circle and an angled contour along two straight
rails.
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Thisimage demonstrates a more complex surface created by using curved rails and curved cross sections.

Activating the Sweep Two Rails command will open the sweep two rails dialogue. The provided parameters will change
depending on whether creating a mesh, or using a relief modification application method.Parameters

Parameters

When the Sweep Two Rails command is activated the Relief Dialogue will activate and the wizard prompts will guide the
creation of a swept surface.

EnRoute User Manual - Page 95



Modifying Reliefs

After creating reliefs, they can be modified through a number of EnRoute fools to create a finished design.

Standard Modification

All of the basic object operationsin EnRoute can be applied to relief objects. Cut, Copy and Paste functions can be used
to duplicate or move relief objects to different locations within the workspace. Reliefs can be removed from the work-
space by using the Delete function.

Cut, Copy, and Paste functions can all be accessed through the Edit menu, or through their keyboard shortcut. Delete is
also available in the Edit menu, or by pressing the Delete key.

Function Shortcut

Cut ctrl + X

Copy ctrl+C

Paste ctrl +V
Clear Relief

K

Clearing arelief deletes the relief surface, but retains the perimeter contour that defined the relief. This tool is used most
frequently to delete arelief so that it can be recreated with different parameters.

To clear arelief, select the relief object, and then activate the Clear Relief command.

Rotate and Move Relief
Reliefs can be moved and rotated like any other object in EnRoute using the Move or Rotate functions.
Move

Rotate

Merge Reliefs

A\

Merge one or more reliefs with a base relief and preserve the copies of the merged reliefs.

Dialogue

When the Merge Relief command is activated a dialogue window will appear with a standard set of parameters for the
application method and wizard prompts.

Common Tool Parameters

Below is an example of a starrelief merged into an elliptical base relief.
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1. Create Reliefs

2. Positionreliefs for merging

3. Activate the Merge Reliefs command
4. Selectthe base relief fo modify and advance the wizard step
5. Select allreliefs to be merged into the base relief

6. Select the Application Method for merging the reliefs, this example uses Add to Relief

Y -§¥-F 1=

7. Execute Merge Reliefs through the wizard command
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Combine Reliefs

oA\

Combine multiple reliefs into a single surface.

overlap, they will be combined into a single surface. If one relief is entirely enclosed within another,

it will create a hole in the relief.
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Invert Relief

2

Invert the relief surface relative to the perimeter contour.
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Apply Draft Angle

Bk

Apply a draft angle to vertical relief surfaces. Parameters for Draft Angle and Height Threshold define how draft angles
are created. Height Threshold refers to the starting height of the draft angle.

Below is an example of arelief surface before and after a draft angle is applied to the vertical surfaces.
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Create Mesh from Relief

(B

Create a mesh from an existing relief surface. A Mesh Tolerance parameter defines the minimum dimension to be cap-
fured by the mesh. The mesh is created in the same position as the original relief.
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On the leftis arelief created in EnRoute and on the right is the mesh created from the relief.
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The mesh facet size is varied depending on the size of detail in the relief.

Offset Relief Surface

Modify arelief surface by applying an offsetf to the existing surface by an Offset Amount. Below is an example of arelief
surface before and after an offset was applied.

/

SURIA
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Scaling Reliefs

Reliefs can be scaled similar to other EnRoute objects by clicking and dragging one of the corner selection boxes or by
using the Scale tool.

When scaling reliefs it isimportant to consider that the relief resolution is also scaled. If arelief is created with a resolution
of 100 dpiand then scaled to be ten times larger, the relief now has aresolution of 10 dpi. The image below illustrates this
concept. On the leftis the original relief and on the right is the scaled relief which has decreased resolution along the
scaled axis.

Fit Relief to Plate

&l

Automatically scale the reliefin the Z dimension of the plate definition.

Smooth Reliefs

4

Apply asmoothing effect to arelief fo reduce sharp edges. Inputs for Smoothing Radius and Smoothing Power adjust
how much the selected reliefis smoothed.

Smooth Relief can be applied multiple times to increase the smoothing effect.

Below is an example of arelief before and after smoothing.
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Extract Relief Slices
\4

=
Cut areliefinto horizontal slices, allowing material o be stacked to create larger objects. If a final design height is 4

inches, the design relief can be cut into 3 horizontal slices so it can be cut from 1.5 inch material and assembled into the
final design.

Extract Slice Parameters

Slice Thick- Thickness of each slice, typically the thickness of material
ness

Slice Count Number of slices to create

Slice Bottom Location of the bottom of the first slice. Most commonly the bottom of a relief, but it can be increased
slightly to remove a flat relief background

Produce Generate masking contours for toolpath creation
Mask

Mask Offset Offset masking contours from the slice edge. Provides room for the toolpaths to over cut the slice
Separate Separates slices into separate drawing layers when enabled

Layers
Apply Creates slices with selected parameters
Close Closes tool without slicing
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Vertical Positioning

Vertical positioning of reliefs is very important when generating toolpaths. In addition to the Move function, several fools
are provided for accurately positioning reliefs in the Z axis. The table below describes each of the vertical relief pos-
itfioning fools.

Aligns each of the selected reliefs to the Bottom of the plate

Aligns selected reliefs to the Bottom of the plate without changing the relative position of the reliefs within
the selection

- D~

Aligns each of the selected reliefs to the Top of the plate

Aligns selected reliefs to the Top of the plate without changing the relative position of the reliefs within the
selection

D] -

Aligns each of the selected reliefs to the Middle of the plate

Aligns selected reliefs to the Middle of the plate without changing the relative position of the reliefs within
the selection

Aligns contours for selected reliefs to the top of the plate. This is the default location.

- b -
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Using Bitmaps

Bitmayps can be used to modify relief surfaces. EnRoute utilizes the gray scale shading of a bitmap to modify the height of
arelief. Bitmaps can be an efficient way to apply texture to a design.

Apply Bitmap to Relief
|

Modify arelief surface using a bitmap by using the bitmap gray scale to vary the relief height. The Height parameter con-
frols the maximum height of the applied bitmap, and the Application Method is the same as the Common Tool Para-
meters.
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1. Import the bitmap into the workspace containing the relief surface

3. Activate the Apply Bitmap command
4. Setthe Height and Application Method parametersin the dialogue window

5. Click Apply to create the finalrelief

EnRoute User Manual - Page 108



Using a Mask

Any contour that is not part of the relief boundary will act as a mask when applying a bitmap to arelief surface. Before
activating the Apply Bitmap command, select the relief, bitmap, and masking contours to automatically incorporate a
mask. The masking contour will limit the application of the bitmap to within the masking contours.

3D Bitmap Effects

Realistic 3D effects can be created using bitmaps, if the bitmaps are made for the purpose of importing into EnRoute.
The gray scale values of the bitmap are used to add to the relief surface up to the specified Height parameter with white
colors applying the full Height value, black colors applying zero height, and shades of gray applying intermediate
heights.

Below is an example of a gray scale drawing created for the purpose of modifying a relief.

-
=
-~

When applied to arelief, notice that the white areas of the waves create the tallest sections of the relief, and the black
background has no effect.
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The same effect can be applied fo a photograph. Itisimportant to note that the gray scale informationin a photo may
not communicate realistic 3D dimensions and not all photos will yield the desired effect when applied to arelief. Below is
an example of arelief surface created from a photo.
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Textures

EnRoute contains a variety of texture tools to quickly and easily apply unique texture to reliefs.

Parametric Textures

»  Continuous three dimensional textures that can be scaled to fit any size relief

»  Customizable and shareable to otherinstances of EnRoute
”  Multiple textures can be layered for unique effects

»  Automatically match the relief resolution

Symmetric Textures

»  Continuous three dimensional textures similar to paramertric textures

»”  Symmetric textures are optimized to by symmetrical across a defined panel size

Rapid Texture

»  Utilizes the size and shape of the cutting tool as a design parameter

»  Generates textures that can be quickly machined

Rapid Picture

» A specialty use of Rapid Texture that uses animage to control texture dimensions

Parametric Textures

Built in textures that can be applied to any relief.

Texture Dialogue

After activating one of the Parametric Texture tools a dialogue window will appear.

1

Each texture has an information button to provide detailed information on texture specific parameters.

Every texture tool has an Application Method and Height parameter that works the same way as in the Common Tool
Parameters.

Templates

Custom texture parameters can be saved as a template for easy reuse. In the femplate section of the dialogue window,
click the save button and enter a Name info the message box to save the current parameters to a femplate. Templates
canthen be loaded from the same texture tool to reload the same parameters.
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Texture Types

Bamboo

Dots

Flagstone

Flame

Flow
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Hexes

Mudpot

EnRoute User Manual-Page 114



MultiFract

Phase

Terrain

Veneer

Weave
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Wood

Symmetric Textures

Create textured surfaces that are symmetric within a specified panel. Symmetric textures are defined very similar to Para-
metric Textures except for the Density Parameters and Panel Definition.

Density Parameters

Each symmetric texture has a set of Density Parameters fo control how many times the texture is replicated within the
panel, defined by the Panel Definition parameters. For the Basic fexture, the density parameters are named Waves X
and Waves Y, and they control the number waves in each dimension.

Below is an example of the Phase 2 texture

Below is the result of applying the same Phase 2 texture with an X density of 2 and a Y density of 2. The resulting piece is
symmetric fop to bottom and side to side allowing multiple panels to be cut with the same design that can be
assembled on alargerscale.
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Rapid Texture

Create a textured surface utilizing the cutting tool dimensions as the primary influence on the final shape. The resulting
design has several interesting characteristics:

»  Number of toolpaths required to cut the final part are greatly reduced, decreasing production time
»  No tooling marks to remove, reducing surface preparation post production before a finish is applied

» 3D surfaces canstill be incorporated info Rapid Texture designs
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Seed Contour

Rapid Texture is generated by creating offset contours and then distorting them. To create the offsets, a seed confouris
required as a starting point. One or many seed contours can be used to generate Rapid Texture, and the seed contours
can be open or closed contours. The seed contour must extend beyond the panel boundary to fully cover the panel.

Itis not required to select a seed contour to generate rapid texture. If no seed contouris selected, a horizontal

line along the X axis of the panel boundary will be used as an automatic seed contour.

Panel Definition

The panelsize can be set through the Panels tab in the Rapid Texture dialogue window. A closed confour can also be
used to set the rapid texture boundary.

Below is an example of a typical open Seed Contour and a square closed contour defining the panel boundary.

e = LR 11 |

The resulting rapid texture is pictured below
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Rapid Texture Dialogue

After activating the Rapid Texture command, a dialogue window will appear with parameters to define the output.

Panels Tab
Template Save parameters to a template for future use
Position Defines the X and Y coordinates lower of the panel lower left corner
Size Size of the panels to create
Rows Number of panels in the X axis
Columns Number of panels in the Y axis
Overlap The amount the contours will overlap the panel edge. Typically 1/2 the tool width to ensure the tex-

ture extends to the edges correctly

Displacement Tab

Wavelength Define the minimum distance between crests in the texture pattern in all axis

Offset The offset between each of the offset contours. Tool size is important to consider
when setting this parameter

Horizontal Amplitude Height of the noise curve in the X and Y plane relative to the offset contour
Vertical Amplitude Height of the noise curve in the Z axis relative to the offset contour
Noise Displacement Distort the offset contours in a non-uniform pattern.
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Wave Displacement Distort the offset contours using the Wavelength and Amplitude settings

Randomize When Noise Displacement is enabled, randomize the noise distortion so that no 2
contours match

Symmetric Generate panels with symmetric edges in the X and Y Axis allowing multiple panels
to line up to create a larger texture. Default horizontal Seed Contour is recom-
mended. Requires Noise Displacement and Randomize to be Enabled. Overlap
must be defined for continuity between panels.

Parameters Tab
Fade Left and Fade Define a distance over which the Rapid Texture distortion on the offset contours fade out
Right to each side of the seed contour. Once the fade out is reached, the offset contours will
match the seed contour.
Resolution The resolution of the noise pattern. 25 dpi by default.
Cleanup Tolerance Define the minimum distance between points that define rapid texture contours. 0.01

inch to 0.001 inch is a standard range and yields smooth results. Larger values will
reduce the smoothness of the generated curves.

Rapid Picture

Generate Rapid Texture using animage to define contour parameters.

Photo Selection

Color photos yield better results than black and white photos. Black and white images are more uniform and resultin
more uniform contours. In this example a black and white photo was used and the originalimage is shown on the left.
Several edits were made fo the photo to increase the contrast between light and dark areas to improve the Rapid Pic-
ture results.
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Import the image into the workspace

4. Move theimage fo the center of the panel

Define the plate dimensions. This example uses a 15" x 15" panel of 0.5" thick material

Scale the image to the panelssize. For this example the photo size is 13"x 13" to allow for a 1" border

Withimage selected the Hold down Alt + Ctrl and press the 5 Key on the number pad to automatically

snap the selection to the plate center.
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5. Use the Rectangle tool to create a contour at the plate boundary

Enable Snap to Grid to easily create a Rectangle by Corners that defines the plate boundaries. Note
the default grid size is 1 inch intervals.

6. Draw a Seed Contour for Rapid Texture generation
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10.

12.
13.
14.
15.
16.
17.
18.
19.

20.

Select the Seed Contour and activate the Rapid Texture command

Left Click on the image to open the tool selection dialogue. Select the tool that will be used to cut the toolpaths.

This example uses a 0.02 engrave tool. Click Accept

Define the Whitespace Gap which controls the minimum separation between contours in dark areas of the

photo. Click OK

Aninformation box will appear with the selected parameters, click OK

Define the Rapid Texture parameters
Parameters for the example pictured
Position: X=1,Y=1

Size = 13"x 13" (Image Dimensions)
Wavelength=3.5

Horizontal Amplitude = 1.5

Vertical Amplitude =0.01
Offset=0.15

Noise Displacement Enabled

Click Apply to create contours.
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21. Selectone of the contours, all of the generated contours are grouped at this point. Activate the Engrave com-

mand ﬂ

22. Setthe Engrave parameters.
a. Forthis example the following parameters were used
i. Tool=0.02"Engrave
i. Depth=0.01"
ii. Follow Contours =Checked

iv. Feed Rate = 60inches per minute

©

23. Click OKto generate Toolpaths. Group the toolpaths together while they are selected

24. Apply arouting offset to the panel conftour
a. Example parameters
i. Tool=1/4"End Mill
i. Depth=0.5"
ii. External=Checked
25. Apply an Engrave toolpath to the panel contour to add a beveled edge o the design
a. Example parameters
i. Tool=90 Conic
i. Depth=0.2"
ii. 3D Engrave Toolpath = Checked

iv. Internal=Checked

26. Use the Simulate 3D |:' tool to create arendered view of the toolpaths

EnRoute User Manual - Page 124



27.

The projectis now ready to cut
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Chamfer

Chamfer tools modify reliefs by applying profiles around the perimeters of contours. Chamfer tools can only be used to
modify reliefs and cannot create mesh objects.

The reliefin the image below is an example of arelief created by the Chamfer Centerline tool by applying a simple pro-
file to a set of confours fo modify an elliptical relief.

Common Chamfer Tool Parameters

Chamfer tools use a set of common parameters fo modify the created relief or mesh.
Application Method

'Y S-F 1™

All of the relief modification application methods are the same asin the relief cre-
ation tool.

Application Methods

Relief Parameters

»  Base - Defines a base height to be added to the extruded surface when applied to the relief

Wizard Prompts

When the command is activated, the wizard will provide prompts for each step to complete. The wizard also provides
buttons to complete steps or cancel the tool.
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Start

Back

Next

Execute

Cancel

Standard Chamfer

D

Return to Start

Go back one step

Go to the next step

Execute the function

Cancel the function

The Standard Chamfer creates a shaped perimeter around an existing relief using a profile. An analogy for this method is
using arouter and a shaper tool to around a block of material. Below is an example profile used to create a chamfered

edge.

The Standard Chamfer tool modifies the existing relief first by creating a relief the height of the selected profile, and then
by removing the material around the perimeter of the relief to match the selected profile. Below is an example of arelief
created using a Standard Chamfer on a flat relief with zero height, using the sample profile above.
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The relief has sharp corners similar to a result a router with shaper tool would create

The graphic below illustrates how the Standard Chamfer tool creates the final relief.

-
B
4

The height of the profile is added to the relief.

The profile is passed around one side of the relief.

Relief shape after the first pass.

The profile is passed around the other side. Note that when
the relief width is less than twice the profile width, the relief will
be truncated where the profiles overlap.
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Final relief shape.

Below is the resulfing relief in EnRoute.

Standard Chamfer Dialogue

When the Standard Chamfer command is activated, the tool dialogue will appear. A set of standard parameters are
available to control the relief shape.

Not allcommon tool parameters are used by the standard chamfer and some will not be visible in the dia-

logue.

Common Tool Parameters

Miter and Centerline

Define how the chamferis applied in the corners. Either Miter or Centerline can be applied af one time to arelief, or they
can be disabled. The effects of each option are best explained with examples. The image below illustrates the effect of
the Miter option in corners.

Itis standard convention fo place the high side of the contour to the left when applying a Standard Chamfer
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With Miter Without Miter

If the desired profile does not follow the standard convention of placing the high side on the left, the Centerline option
will prevent the Standard Chamfer tool from cutting through the profile. As the profile is passed around the perimeter, it
will overlap itself at several points and truncate the relief. If this is not the desired effect, the Centerline option prevents

the Standard Chamfertool from fruncating in the corners of the relief. The image below illustrates the effect of the Cen-

terline option.

Y

Miter Option Centerline Option

Chamfer Centerline

A

Apply a chamfer to arelief using a profile that is scaled and extended to the contour centerline to create a symmetric
surface. More natural looking surfaces can be created using the Chamfer Centerline tool than the Standard Centerline
tool. Below is an example of arelief created with the Chamfer Centerline tool.
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Forcomparison, the left relief was created using the Standard Chamfer tool and the right relief was created with Cham-
fer Centerline. Note the smooth edges created by Chamfer Centerline.

Chamfer Centerline Dialogue

When the Standard Chamfer command is activated, the fool dialogue will appear. A set of standard parameters are
available to control the relief shape.

Common Tool Parameters
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The Constant Height relief option works well with the Chamfer Centerline tool and creates smoother surfaces. The image
below illustrates the difference between the Normal and Constant Height relief options when applied to the same relief.

Normal Constant Height

Chamfer Carve

A

Create a chamfered surface with a non symmetrical surface by specifying a different profile for the inside and outside
surfaces. The example images below show the contours for the relief shape, inner and outer profiles, and the resulting
relief when applied to arelief. The resulting relief has outer surfaces that are convex and inner surfaces that are concave
due to the specified profiles.

o

Baroque Chamfer Dialogue

When the Baroque Chamfer command is activated, the tool dialogue will appear. A set of standard parameters are
available to control the relief shape.

Common Tool Parameters
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3D Meshes

Meshes are a common 3D design format across many soffware design packages. EnRouteis capable of producing 3D
meshes and utilizing existing meshes as part of the relief design process.

Most EnRoute relief tools provide the ability to create meshes that can be positioned, rotated, and scaled before being
incorporated into arelief design.

Creating 3D Meshes in EnRoute

Several EnRoute tools can create mesh objects. The tools below can all create mesh objects.
Revolve

Spin

Exirude

Sweep Two Rails

A set of common confrolsis used for each of the tools fo control the mesh creation.

Common Tool Parameters

Primitives

3
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Create basic 3D shapes automatically. These elements can be used to create more complex shapes or be used directly.

Primitives Dialogue

When the primitives command is activated, a dialogue window will appear. The first option allows the type of primitive to
be selceted.

(SIFIN ¥
P o o
@

The remaining parameters adjust the dimensions and surfaces of the primitive.

X, Y,Z Coordinates for the location of the center of the primitive

Slices Number of sections either around the circumference of the object or along one axis
Stacks Number of sections along one axis, typically the z-axis, of the object

Radius Half the diameter of a circular dimension of the object

Height Z dimension of the object

Size The dimension along one axis of the object, such as ‘X Size’

Sweep Angle For the Torus object, this is the number of degrees of the sweep of the object around the

‘outer’ radius

Close top or Close Bot-  Define if Cylinders, Cones and Boxes should have surfaces that cover their tops and bot-
tom toms

Using 3D Meshes from Other Applications
EnRouteis capable of importing meshes in a few different formarts.

* DXF-Data eXchange Format is the format created by AutoDesk® as a standard method for bringing data into and
out of AutoCAD®. It has become a standard method for exchanging data between many software packages. EnRoute
imports both 2D and 3D data using this format.

¢ 3DS —Thisis the format used by 3D Studio®. EnRoute imports 3D files saved using this format.
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* STL-STereo Lithography is a standard method created for sharing 3D mesh surface data. EnRoute imports STL mesh
objects.

* OBJ - Alias Wavefront mesh format
Applying Meshes to a Relief

&

Modify relief surfaces with mesh objects.

Before using the tool, a mesh and arelief must be selected.

Apply Mesh Dialogue

After activating the apply mesh command, the dialogue window will open. Several parameters influence how the mesh
isintegrated into the relief.

Faceted !

Meshes are composed of facets, triangular sections that define the surfaces. Meshes can be applied to reliefs without
modifying the mesh facets and will be visible in the final relief surface.

Smooth O

Smooth out the mesh facets so that they are noft visible in the resulting surface.

The images below illustrate the differences between the smooth and faceted options when applying meshes to reliefs.
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The Application Methods for applying mesh to relief are the same as the common tool parameters used by EnRoute
relief tools.

Common Tool Parameters

Vertical Positioning

Z axis positioning is important when applying a mesh to arelief. The vertical location of the mesh confrols how much the
reliefis modified. The images below demonstrate how the position of a sphere mesh with respect to arelief surface
changes the resulting relief.
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Using a Mask
Utilize a closed contour to mask off a section of a mesh to be applied to arelief and ignore the remainder of the mesh.

The following image shows a base relief, alarge 3D mesh of alion, and a ellipse acting as a mask. All three must be selec-
ted before activating the Apply to Relief command to successfully use the mask.

When the Apply to Relief command is executed, only the masked portion of the lionis added to the relief.
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The completed design with added borders show how including a portion of a mesh using a mask can be a useful fool.

EnRoute User Manual - Page 138



Slicing Meshes

Create slices of a mesh object along the X, Y, and Z axis.

Slice Meshes Dialogue

Select a mesh object and activate the Slice Mesh command to open the dialogue window. Several options are
provided to control how the mesh will be sliced.

VA Create slices along the Z axis, horizontal slices top to bottom

X Create slices along the X axis, vertical slices created in the front view

Y Create slices along the Y axis, vertical slices created in the right view

Thickness Slice Thickness, typically the thickness of material used

Number Number of slices, automatically calculated by thickness and object dimensions

Offset The distance from the bottom of the plate to the first slice. Typically 0.0, but can be used to adjust
slice location to fit the model better

Layout Creates separate geometry of the slices when enabled

Label Labels slice geometry when enabled

Model Creates a model to simulate the assembled piece when enabled
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Toolpaths

Overview

Part of any design process is creating toolpaths used to machine the final piece. There are several key topics for creating
toolpaths.

Contours

Toolpaths are derived from the contoursin a design. Contours can define toolpath boundaries in the case of a fill pat-
tern, or toolpaths can trace the inside, outside, or the path of a contour.

Alltoolpaths are generated exclusively of line and arc segments. Bezier segments will be temporarily con-

verted to lines and arcs for toolpath generation

Toolpath Groups

Toolpaths are automatically grouped with the contour they are derived from, creating a toolpath group. Any sub-
sequent toolpaths generated from the same contour are added to the same toolpath group.

Contours can only belong to asingle toolpath group. If there is a need to generate a foolpath using a group of contours,
and generate another toolpath from a contour within the same group, a copy of the contour will have to be created for
the individual toolpath.

When duplicate contours are used, it is best to keep the individual contour in a separate layer to avoid con-

fusion

Strategy

Toolpath strategy determines what kind of toolpath will be generated (Fill, Engraving, Slot, etc). Each strategy has a com-
plete set of parameters to define the final shape of the toolpath. Because the strategy determines the shape of the final
toolpath, EnRoute always refers to the toolpath by the chosen strategy, not the foolpath.

Plan

The planis all of the strategies within any toolpath group.

Cuts

Each toolpath strategy is made up of one or more cuts. Forinstance, a fill can contain a Rough cut, a Fine cut, and a
Clean cut. Each cut uses a different tool and different parameters.

Templates

At each stepin the toolpath creation process it is possible to save a set of parameters to be used as a template to auto-
mate the process.

Cut Template - Saves parameters associated with individual cuts
Strategy Template - Saves strategy parameters and any parameters associated with cuts within the strategy

Plan Template - Saves all associated strategy parameters for a toolpath group and all cut parameters within all asso-
ciated cuts

Templates can be applied fo new contours and recreate all the work for the original toolpath.
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Strategy Dialogue

Alltoolpath strategies in EnRoute use the strategy dialog to define the type of cuts to be performed, which fools to use,
and the relevant parameters for each type of toolpath strategy.

Cut Definition

The top window in the strategy dialog is the cut list and is used to select the tool for each cut and define the cut para-
meters.

Toolpath strategies can have multiple cuts per strategy, a common example is a fill toolpath strategy that has

afillcut, a clean cut, and a fine cut, each with a different fool and set of cut parameters.

To add cuts, select a tool from the Tools list and click the Add Tool button, or double click the tool. The Cut Type will auto-
mafically be set based on the type of toolpath strategy being created and the number of cuts defined.

Toremove a cut from the cut list, select the tool and click to the Delete Tool button, or click the Clear button to remove
all cuts from the cut list.

Depth

The fourth column of the cut list defines the depth of each cut. Cut depths can be defined by either typing a value or by
using the spin edit buttons. Adjusting the depth of one cut willautomatically adjust the depth of any other cutsin the cut
list fo the same depth.

Cuts must have a depth greater than 0, otherwise the strategy cannot be created

Cut Parameters

The Edit columnin the cut list is for defining Cut Parameters, and clicking the cell for a cut will open the cut parameters
dialog.

Strategy Parameters

At the bottom of the strategy dialog is the strategy parameters window. Strategy parameters are different for each type
of toolpath strategy and details of the strategy parameters of each toolpath type can be found on their knowledge
base pages.

Strategy Templates

Toolpath strategies require many settings to be defined to work correctly, and it can be time consuming to redefine the
parameters each time a new toolpathis applied. Every toolpath strategy in EnRoute can be saved as a strategy fem-
plate that can then be reloaded and applied later without having to reset every parameter.

To save the current strategy as a template, in the toolpath dialogue select the Save As button. Type a name for the tem-
plate and click OK.

Toload a settings template, select the Strategy list at the top of the dialogue window and select the tfemplate name.

Cut Parameters

Fine fune each cut within a strategy using the following parameters. To edit cut parameters, select the ellipses in the edit
column of the strategy dialogue.

Current Tool

Displays the currently selected tool. Select a new tool from the list to change the tool used.
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CutType

Define how the cut will be generated relative to the geometry. There are 3 options, Rough, Clean, and Fine. The cut
opftions are automatically determined by EnRoute based on the strategy type and cut order.

The first cut is always defined as a Rough cut and the second cut is automatically defined as a Clean cut. This setup
allows the Rough cut to remove material around the part and the Clean cut fo finish the final cutout.

A Fine cut can also be added which is intended to fit into corners and tight areas the Rough and Clean tool cannot

reach.

Below is an example of the same part with 3 different strategies. The first only uses a Rough cut. The second uses a Rough
and Clean cut. The third part has a Rough, Clean, and Fine cut applied.

Depths

Passes

Width

¢ \\‘ t\‘\y ‘j\"'ﬁ_\ \
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Surface Depth

Final Depth

Number

Max Per Pass

Actual Per Pass

Final Pass

Final Pass Depth

Width of Cut

Number of Steps

Max Step
Actual Step

Shoulder

7 ‘H
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{ \ I
.\\
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The distance from the top of the plate to the top of the design. Default is 0.0

The depth of the cut measured from the surface depth. When surface depth is 0, Final
Depth is the distance from the material surface.

Number of passes that will be created. The minimum number of passes is automatically
calculated by the Max Per Pass value and the Final Depth. Number cannot be set
below the minimum value.

Maximum depth of each pass. The default is automatically calculated from tool dimen-
sions, but can be decreased to control the depth per pass.

Calculated from the Number of passes and the Final Cut Depth. If a Final Pass is
used, the Final Pass Depth is removed from the Actual Per Pass value.

Define a final pass with a different depth than the other passes. Number of passes must
be greater than 1.

Depth of the Final Pass

Define an offset from the part surface a clean or rough cut will follow to leave material for
a clean cut to remove on a second pass. A cut width of 0.0 will generate a Rough and
Clean cut that trace the same surface of the part. A cut width greater than 0.0 will offset
the Rough cut by the width, leaving additional material to be removed by the Clean cut.

The number of passes required for a specified cut width. Automatically calculated based
on the Max Step value and the Width of Cut.

Maximum width of material that can be removed in one step.
Calculated based on the Number of Steps and Width of Cut parameters.

Create a step around the perimeter of the design.
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Feeds and Speeds

Feed Rate
Final Pass Rate
Plunge Rate

Dwell

Spindle Speed

Direction

Conventional

Climb

Speed the tool will move through the material when cutting
If the Final Pass option is enabled, specify the speed for the final pass
Speed the tool will move down into the material

A time delay that will cause the tool to pause between plunging into the material and feeding
into the material

Speed of the spindle during cutting

The tool will turn in the direction of travel. For a standard exterior cut along a contour, the tool
will move in a counter clockwise direction.

The tool will turn against the direction of travel. For a standard exterior cut along a contour, the
tool will move in a clockwise direction.

Toolpath Entry and Exit Parameters

Define how the tfool should move away from the finished edge when moving in and out of cut.

vl

Arc

Line

Combination

Lift Options
Lift Options

Define an arc path for the tool to follow by specifying a Radius and Angle of the arc path to fol-
low. The 3D Arc option can be enabled and a Lift defined to create a 3D entry/exit path.

Define a straight line path for the tool to follow by specifying the Length and Angle away from
the finished surface. The 3D Line option can be enabled and a Lift defined to create a 3D
entry/exit path.

Create a combination arc and line entry/exit path by specifying Radius, Angle, and Length.
The tool will follow a straight line to approach the finished surface and then arc into cut, or
reverse for an exit path.

For Routing Offset and Engrave type strategies, the lift type between each pass can be specified.

3D Toolpaths

Create a 3D cut. A 3D toolpath must be created with a conic, tapered, or engraving tool. A 3D toolpath uses the

beveled shape of the fool to create a beveled edge on the finished piece. The tool will also move into the corners as far

as the tip dimension of the tool will allow.

EnRoute automatically monitors the type of cut and type of tool and will only allow 3D toolpaths to be enabled when

appropriate.

The following image is an example of a piece cut with 3D toolpaths.
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Lift Options.htm

Routing Offset Toolpaths

O

Create atoolpath that runs either inside or outside of a closed contour. The toolpath is offset from the contour by the tool
radius to the edge of the cut surface will align with the contour perimeter.

Routing Offset toolpaths can only be applied to closed contours

If a cutting fool cannot follow the contour shape into a tight corner or curve, the toolpath will follow the closest smooth
curve possible.

—_——
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Activating the Routing Offset fool will open the strategy dialogue. Use the Strafegy Dialogue to add and remove cufts.

Set the Cut Parameters for each cut to define how the Routing Offset will be generated.

Steps

1. Selectthe contour for the toolpath to follow

)

3. Inthe Routing Offset dialogue, select the desired tool from the Tools list and select Add Tool

2. Activate the Routing Offset command

The Sort by list sorts the Tools list by parameter or tool type

The first tool in the list is always defined as the Rough tool, and is typically the main cutting tool. Addi-
fional tools serve as the Clean or Fine fools

4. Define a Depth for the selected toolin the tool listing window
5. Add additional cuts using other fools as necessary

6. Setthe Routfing Offset Parameters

External (Male) When checked, the toolpaths will follow the outside of the contour

Internal (Female) When checked, the toolpaths will follow the inside of the contour

Weld Offsets When checked, overlapping offsets will be welded together to form a
single toolpath group. If unchecked, overlapping offsets will remain
unchanged

Sharp Corners Offset toolpaths from square corners are rounded by default, allowing for

smoother machine operation without rounding the contour perimeter.
When checked, this parameter forces toolpaths to be generated with
square corners. It is generally not recommended to enable this paramter.

Inlay If checked, the toolpath defines either the socket for an inlaid piece of a dif-
ferent material (if the toolpathis set to Internal), or the cut that will separate
the inlay itself from the plate (if the toolpath is set to External).

Because around bit is being used to cut out both pieces, both
the male and female toolpaths need to take into account the

dimension of the tool. This changes the shape of the toolpath,
particularly in corners.

If this option is checked, the Inlay Gap parameter displays. This parameter
indicates the size of the gap that will exist between the inlay and its socket.

Bridges When checked, generated toolpaths will leave small tabs of material
uncut fo connect the design to the remaining material sheet. Additional
parameters are activated to define the bridge shape when this option is
checked.

7. Click OK
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After toolpath generation, the contour will become part of the toolpath group

Bridges

Bridges are lifts in Routing Offset toolpaths that create tabs that maintain the connection between part being cut and
the materialitis being cut from. Bridges improve stability so the part does not move while being cut. The tabs are
frimmed away after cutting the part.

Bridge Parameters

Type Define the shape of the bridge. Each shape has advantages for different materials, while
smooth bridges allow for the smooth machine operation

Length Length of each bridge. Longer bridges have increased strength, shorter bridges work well in
stronger materials

Height Height of each bridge tab. Another parameter to influence bridge strength
By Number Define the number of bridges in an offset

By Length Define the distance between each bridge

Manual Define specific bridge locations along the offset.

All bridge positions can be edited after generation

Bridge Shapes

Lift

Ramp

Smooth
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Ramp Mesa

Smooth Mesa ~——__

Open Contour Offset Toolpaths

S

Generate toolpaths similar fo Routing Offset toolpaths, except for open contours.

Strategy

Activating the Open Contour Offset tool will open the strategy dialogue. Use the Strafegy Dialogue to add and remove
cuts and define strategy parameters.

Side

Define which side of the contour to place the toolpath. Left or Right of the contouris determined as if facing in the dir-
ection of the contour. Middle will follow the path of the contour.
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When open contour offset toolpaths cross design boundaries, it can be beneficial fo have the fool enter the material at
both ends. When a tool exits materials like wood, it can cause a blowout where the material breaks apart at the edge.
The With Relief option allows a segment at the end of the toolpath fo be defined where the tool will move in the opposite
direction so that it enters the design rather than exits.

The image below displays a contour with the option enabled. Note that at the right end of the cut, the arrow isreversed.
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Relief Length The length of the toolpath at the end that the tool will move back in from the end
Relief Overlap Distance to overlap the two cuts to ensure a clean cut
Cut End First When selected, the Relief section of the toolpath will be cut first

Cut Parameters

The Cut Parameters are similar to the Routing Offset toolpaths with a few exceptions.
» 3D toolpaths cannot be created for open contours.
»  The direction of the cutis defined by the direction of the contour.

»  Open contours can be used to cut out wide areas by specifying the cut width.

Kerf Compensation Toolpaths

h
(=Y

A simplified foolpath tool designed for CNC cutting devices other than routers. The tool behaves similar to the Routing
Offset tool, but only the necessary 2D parameters are available. Kerf compensation also provides a parameter to
enable and define toolpath loops in and out of external corners to maintain cutting head speed for water jet and
plasma cutters.

Kerf Width 0.05, 0.10, and 0.15 are default, additional options can be added.
External (male) Toolpaths will follow the outside of the contours
Internal (female) Toolpaths will follow the inside of the contours
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Feed Rate The speed the tool will move in the material when cutting

Weld Offsets When checked, overlapping offsets will weld together into a single toolpath group. If
unchecked, overlapping offsets will remain separate

Loop Corners Create toolpath loops on external corners. Loops prevent the tool from decelerating
as it rounds the corner.

Sharp Corners When checked, toolpath offsets form square corners
Direction - Conventional Cutin a counter-clockwise direction for a standard exterior cut

Direction - Climb Cut in a clockwise direction for a standard exterior cut

Entry and Exit Parameters

Define how the tool should move away from the finished edge when moving in and out of cut.

Arc Define an arc path for the tool to follow by specifying a Radius and Angle of the arc path to fol-
low. The 3D Arc option can be enabled and a Lift defined to create a 3D entry/exit path.

Line Define a straight line path for the tool to follow by specifying the Length and Angle away from
the finished surface. The 3D Line option can be enabled and a Lift defined to create a 3D
entry/exit path.

Combination Create a combination arc and line entry/exit path by specifying Radius, Angle, and Length.

The tool will follow a straight line to approach the finished surface and then arc into cut, or
reverse for an exit path.

Corner Force the toolpath start point to coincide with a corner, and the entry and exit paths to align with
the edges of the corner. If either the entry or exit type are set to Corner, both the entry and exit
paths will be generated at the toolpath corner.

Engrave Toolpaths

Lk

Create 2D or 3D engraving tfoolpaths. 2D toolpaths follow the selected contour exactly to add a beveled effect. 3D
foolpaths use the shape of the engraving tool fto more accurately cut out sharp corners.

Only tools capable of engraving including conic, engrave, and tapered fools can be used to generate

engrave foolpaths.

Cut Parameters

Parameter for Depths, Passes, Feed and Speeds, and Direction match the other toolpath Cut Parameters.

3D Engrave When checked, the engrave will be created as a 3D toolpath. If unchecked, a 2D
Toolpath toolpath will be generated.
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External or When 3D Engrave Toolpath is checked, it must be specified if the toolpath should pass
Internal to the inside or outside of the contour.

3D engrave toolpaths require all selected objects fo be combined info a
single toolpath group. Existing toolpath groups included in the selection will
be deleted when creating engrave toolpaths.

Strategy Parameters

The first tool defined in the engrave strategy is always the engrave tool, and the second toolis defined as the rough tool.
Toolpaths for the rough tool are only generated if required by the engrave cut.

A common configuration for deep engrave cutsis fo define rough cut that uses an end mill fool to remove

excess material.

Square Corners

For External 3D Engrave toolpaths, there is an additional option for square corners which will create squared toolpaths at
cornersin the contour and change the finished surface.
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Hatch and Island Fill Toolpaths

=

Generate toolpaths for milling large areas.

Hatch Fill

Island Fill

Hatch vs Island Fill

Efficiency and surface finish are the two most important considerations when choosing between hatch and island fills.
Generally when cutting a large area the hatch fill will be the most efficient. If a design is made up of long, thin sections,
the island fill will be the most efficient. Both methods leave a distinctive surface after milling and if the surface finish of the
final design isimportant, it could drive which method to use.
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Types of Cuts
There are three types of cuts that can be defined in a Hatch Fill strategy: Fill Cut, Fine Cut, and Clean Cut.
Fill Cut Define the tool to perform the Hatch Fill.

Fine Cut -(optional) A tool with a smaller diameter than the Fill Cut that fits into corners and thin areas
too small for the Fill tool. The amount of overlap between the fine cut and adjacent
toolpaths must be specified.

Clean Cut - (optional) Define a tool that generates toolpaths offset from the contours to improve the fin-
ished edge of the design or to utilize a 3D engraving toolpath.

The image below illustrates a hatch fill strategy with afill cut and 3D engrave clean cut.

Strategy Parameters
Inlay

Definesif the strategy will be used as the female part of aninlay project. The toolpath must compensate for the tool
dimensions and account for aninlay gap, which is the spacing between the male and female portions of the inlay. The
images on the left below show toolpaths without with out inlay and the images on the right have inlay applied and high-
light how the toolpaths are modified in the corners.
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Optimization
There are three different options for how the hatch fill cuts the contour.
Standard Minimize the number of tool lifts, do not allow the hatch toolpath to pass over any part of the

hatch area more than once, and enforce a strict back-and-forth pattern across the cut area

Nose Cone Generate hatch toolpaths for compatibility with a Nose Cone engraving tool. Maintain an
edge of uncut material next to the nose cone to maintain a constant cut depth.

None Cut the cleaning pass before the associated fill cut.

Hatch Fill Cut Parameters

Hatch Fill toolpaths use the common Cut Parameters . A couple of unique parameters to control the Fill.
Overlap Define the overlap percentage between adjacent toolpaths. Valid values range from 0-99
with a default of 50. A general rule of thumb is that softer materials require less overlap and

harder materials require more overlap. This value can also be changed to achieve a desired
surface effect.
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Hatch Angle Define the angle with respect to horizontal that the toolpaths will be generated at. A hatch
angle of 0 degrees will generate a horizontal fill pattern and 90 will generate a vertical fill.

e 1

"

ot =
7

Island Fill Cut Parameters

Island Fill foolpaths use the common Cut Parameters. A Corner Tag parameter defines if additional foolpaths will be gen-
eratedin corners. Corner tags are important when the overlap is set to less than 50 percent to ensure the entire areais
milled. The images below show a star contour on the left with corner tags, and on the right without.

W
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Spiral Fill Toolpaths

Create atoolpath that spirals out from the center of the contour. Spiral toolpaths are most efficient forround or near
round design elements which allow the contour to be a single continuous spiral and eliminate the need for tool lifts.
Objects that are not round require the tool to lift every fime it encounters an edge creating more lifts than a normal
Island Fill or Hatch Fill.

The images below illustrate a spiral fill toolpath for a circular contour and a square contour.

7

Pyramid Toolpaths

a’

Generate toolpaths to create a beveled design using the fool dimensions and design to determine cut depth.
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Only tools capable of engraving including conic, engrave, and tapered tools can be used to generate pyr-

amid toolpaths.

Strategy Parameters

The first tool in the strategy is always defined as the Pyramid tool.

Return Height The height of a vertical edge to be created below the beveled portion of the cut. Move to
bottom of plate must be checked for Return Height to be cut correctly.

Move to bottom of If checked, the bottom edge of the return height will be aligned with the bottom of the plate.
plate If unchecked, the toolpaths will be placed so the top of the beveled surface will be at the
surface of the material.

Cut Parameters

Pyramid toolpaths share many of the same Cut Parameters as other toolpaths. The key difference is that the depths of
the cuts are automatically defined based on strategy parameters. The Surface Depth for the cuts can be overridden,
butis not recommended.
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By default, EnRoute utilizes 90 percent of the tools cutting depth for the Pyramid cut. This is likely appropriate for soft
materials, but for denser material like wood, it will likely be necessary to decrease the pass depths by increasing the num-
ber of passes.

Drag Knife

P

Create atoolpath for a knife to cut the selected contours.

1. Selectthe contours to apply toolpaths to.
Activate the Drag Knife tool

2
3. Select aDepth, and define the Strategy Parameters and Cut Parameters
4

Click OK.
Strategy Parameters
Lift Corner Lift the knife in corners of the contour being cut
Lift The amount to lift the knife by in corners
Align
Radius Corner Cut corners in the selected contour with a radius
Radius The size of the radius to apply to corners in the contour

Loop Corners - Outside Corners Only Loop the knife around external corners

Loop Standoff The size of the loop the knife follows at external corners

Cut Parameters

Drag Knife Toolpaths use a subset of the common toolpath Cut Parameters.

Editing Toolpaths

Aftertoolpaths are created, the toolpaths retain all of the information about how they were generated. Toolpaths can
be edited at any time to change the cut and strategy parameters.

To edit atoolpath:
1. Selectatoolpath

2. Fromthe Toolpath menu select Edit Toolpaths, orright click the toolpath and select Edit Toolpaths from the pop
up menu.

3. Ifthe foolpath group contains more than one strategy, the strategy fo edit must be selected from a dialogue
box. Click OK to open the selected strategy.

4. The toolpath dialogue willopen. make the desired changes and click OK.

3D Toolpaths

Most of the same strategies used on other toolpaths can be applied to 3D designs, including Routing Offset, Engrave,
and Hatch and Island Fills. 3D toolpaths require a few additional parameters to define how the relief influences the
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toolpaths.

Strategy Parameters

The parameters required for 3D toolpaths are automatically enabled when one or more reliefs are selected when activ-
ating a strategy. When checked, the Apply to Relief parameter displays the four additional parameters that define how
toolpaths are applied to arelief.

Apply to
Surface

Carve into
Surface

Apply
Overcut
(Fills
Only)

Cut Parameters

Offset from Surface

Toolpaths will follow the relief surface and the depth of cut will be adjusted to follow the relief.
If noreliefis selected, the depthis defined by the cut parameters depth. The cut depth
defines the maximum depth of the toolpaths.

Toolpaths follow the relief while using the cut depth to define how deep to cut into the relief.
Enabling this parameter enables two more.

Project Calculates the toolpaths as if they were projected onto the relief.
(Most common)
Float Calculates the toolpaths so they will not cut into the relief surface.

This option can cause distortion of the toolpaths and should only
be usedin special circumstances when the toolpaths should not
cutinfo the relief surface

Compensate for the dimensions of ball end mills by allowing toolpaths fo extend beyond the
part boundaries. Without this option, the design would leave the radius of the ball nose uncut
around the edges.

A goodrule of thumb is to set overcut to alittle less than 1/2 the ool diameter on

the finish pass

Set how close the toolpaths will follow the surface of the relief. Typically defined forrough cuts to ensure the roughing
pass does not damage the finished surface. Offset is detfermined by the type of material, type of fool, and how fast the
roughing pass should run.

The image below shows toolpaths with a 0.20 offset.
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Step Rough

Available for Hatch and Island Fills. Create optional toolpaths to rough out the relief surface before creating the finish
foolpaths.

This method is more efficient than standard 3D rouging passes because it creates 2D toolpaths at multiple pass depths fo
remove as much material as possible at that depth. The 2D toolpaths can typically be defined using higher feed rates
than 3D toolpaths.

Animportant consideration when applying a step rough is that the ball end mill used for the final pass must be capable
of cutting the steps that remain after the step rough. The height of each step is the difference between the depths of
each passin the step rough.

Key 3D Toolpath Concepts

Three axis routers create 3D objects by making incremental cuts with a ball end mill fo remove material from the finished
surface. The size of the tool, the amount of overlap, and how much detailis required are all constraints. The relationship is
the smaller the tool, the larger the overlap, and the finer the detail, the longer the design will take to cut.

In general the finish cut should be run as a single pass because it takes the longest time to run. The rough strategy clears
material out of the way for the final cut and goes a long way to getting the job done. It isimportant to use the EnRoute
visualization tools to ensure the job will cut correctly because the depth of cut can vary greatly across large 3D surfaces.
Itis easy to getinto tfrouble using a small tool to make a deep cut, but EnRoute provides tools fo avoid these situations.

Overlap

Itisimportant to select the proper overlap percentage when miling a 3D surface to achieve the desired surface finish.
Milling 3D relief surfaces requires the use of a ball end mill fo cut smooth surfaces. The spherical surface of the tool cre-
ates small grooves in the finished surface which vary in size depending on the amount of overlap. As overlap increases,
the tool marks are reduced while increasing the cut time. The goalis to balance cut fime and cut quality.

The best way to determine overlap is to cut a test relief using the same material as the job fo estimate cut time, the sur-
face quality, and the amount of finishing work.

Typical overlap values range from 80% on larger reliefs with larger tooling marks, to 95% for small reliefs with a smooth fin-
ish.
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Toolpath Ordering

Bo,

Review and edit the order assigned to toolpath groups. The toolpath order influences the orderin which cuts will be
made.
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Ordering Toolpath Groups Manually
1. Inthe Order Toolpath dialogue, use the horizontal blue arrow buttons to select toolpaths. The selected toolpath is

indicated by a bold red number.

Use the vertical green arrow buttons to change the cut number of the selected foolpath.

3. Click OK when finished.

Pressing the arrow keys on the keyboard produces the same result as clicking on the blue and green arrows.

Order Manually using the Mouse

1. Selectthe Manual optionin the Order Toolpath dialogue.

2. Clickeach toolpathin the desired order
3. Click OKwhen finished

Order Toolpath Groups Using Sorting Methods

Select the sorting method from the Current Sort Method list.

Shortest Produce the shortest overall set of toolpaths and movements

Rows Order toolpaths in rows starting at the bottom of the plate and numbering left to right
Columns Order toolpaths in columns starting at the left of the plate and numbering top to bottom
Inside Out Sort toolpaths by position from the center of the plate to the edges

Outside In

Sort toolpaths by position from the edges of the plate to the center

EnRoute User Manual -Page 161



Order by Line

£

Define the tfoolpath cut order by drawing a path between the toolpaths using the mouse.

After the toolpaths have been arranged on the plate, activate the Order by Line tool. The cursor will change to a cross to

indicate the toolis active.

1. Clickand dragin the plate to define the fool movement.

\

M _m

-

3. Press Enterto accept the cut order. The view will change to show the new order and it can be reviewed using the

simulation tools.
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Preview Output.htm
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4. Right click fo exit the tool.

Group Order

Ordered objects within a group will maintain the original ordering when copied.

1. Selectthe objectsin the order to be cut, then Group them together.

2. When the group is copied, the order of the group is also copied.
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Drill Tools

Drill points are similar to toolpaths but can be interpreted differently by many CNC machines. EnRoute creates drill points
differently than toolpaths so that the machine driver can determine how much information to send to the machine.

Drill points are all created with the same cut parameters in EnRoute. There are six fools that create drill points in different
arrangements.

Drill Strategy Templates

Similar to toolpaths, drill strategies can be saved as templates and reloaded later. Within the drill strategy dialogue, type
aname into the Strategy box and click the Save As button to save the current strategy as a template. The template can
be reloaded by selecting the template name from the Strategy drop down box.

Drill Points

&

Create asingle Drill Point at a specified location.

Parameters
X and X and Y location for the drill point
Y Coordinate
By Graphic When checked, the Drill Point will be located with the mouse
Drill Circle
B
@8
[ 3)

Create a circular pattern of drill points centered about a specified location.
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Parameters

Circle Diameter

Angle

Number of Holes

X and Y Coordinate

By Graphic
Drill Array
B1Q
[l
[l
el

Diameter of the circle the drill points will be generated around. Must be greater than
zero.

Rotate the drill points about the center by the specified angle. An Angle of O will
place the first circle to the right of center.

Number of holes to generate, must be 1 or greater.
X and Y location for the center of the circle

When checked, the circle center will be located with the mouse

Create a matrix of Drill Points with a set number of rows and columns and a defined spacing.

Parameters

Column- Number of vertical drill columns

s
Rows Number of horizontal drill rows
Spacing . . . . I .
Width by Overall Width Specify the overall width of the array, the drill points will be
evenly spaced horizontally within the overall width
Width by Horizontal Spa- Specify the amount of horizontal space between each
cing column of drill points
Height by Overall Width  Specify the overall height of the array, the drill points will
be evenly spaced vertically within the overall height
Height by Vertical Spa- Specify the amount of vertical space between each row of
cing drill points
X and Xand Y location for the bottom left hole in the array
Y Coord-
inate
By When checked, the array will be located with the mouse
Graphic
Drill Centers

Create a drill point in the center of all selected contours. Contours can be filtered so that only circles of a specified dia-

meter are used.

Drill Centers can only be used with closed contours
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Parameters

All Contours Holes will be drilled in the center of all contours
Circles Only Holes will only be drilled in the center circles within the selected contours
All Circles Holes will be generated in the center of all circles

By Diameter Holes will only be generated in the centers of circles within
the Tolerance of the Check Diameter value

Drill Contours

>

Create drill points along selected contours.

Parameters

Drill Corners

®
]

Spa-
cin-
g
Typ-
e

Hol-
es

Spa-
cin-

Hold Number A number of drill points will be generated along the con-
tour as specified by the Number of Holes parameter

Hold Spacing Drill points will be spaced along the contour at even inter-
vals defined by the Spacing parameter

Corners Create Drill points at all corners in the contour
Inside Corners Create Drill points at all inside corners in the contour
Outside Corners Create Drill points at all outside corners in the contour

Circles and Ellipses have no corners and will not have drill points generated for any of the

corner spacing types

The number of holes used by the Hold Number spacing type

The spacing between drill points used by Hold Spacing type

Create drill points af the corners of the plate, and opfional drill points between the corners.
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Drill Corners is only available if a plate has been defined

Parameters
Inset X The horizontal inset from the corners of the plate
Inset Y The vertical inset from the corners of the plate
Add Copies X Create additional drill points spaced evenly between the corner drills along the hori-
zontal axis
Add Copies Y Create additional drill points spaced evenly between the corner drills along the hori-
zontal axis

Drill Cut Parameters

Drill cut parameters for Depths, Passes, Feeds and Speeds are the same as the toolpath Cut Parameters. There are a
couple additional parameters that are unique to drill points.

Diameter by tool vs. Exact diameter

If Diameter by toolis selected the drill point will only be a point and the size of the hole will be based on the diameter of
the tfool at the given depth.

If Exact Diameter is selected, a diameterlarger than the fool diameter can be specified and the drill point will be gen-
erated as a circle. The circle will be sized to create a hole with the selected diameter using the tool dimensions at the
given depth.

When using Exact diameter, EnRoute accounts for the shape of the tool when determining the drill path. For example, a
drill point generated with a conic tool where the drill depthis less than the conic bevel height, the real diameter of the
tool at the drill depth will be used to generate the drill path.

The image below illustrates drills defined with both Diameter by tool and Exact diameter.

SV Ny
7

Countersink

The Countersink option is available when using an engraving capable tool (conic, engraving, tapered) and Diameter
by tool is selected. Countersink allows the specification of the outer diameter of the countersink hole and then auto-
matically calculates the depth of cut based on the tool dimensions.
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Slot Toolpaths
Define a cut along aline, creating a slot the width of the tool diameter. Slots can include multiple tools and depths.
Parameters

Start X and Xand Y coordinates of the starting point of the slot
Y Coordinates

End X and Xand Y coordinates of the end point of the slot
Y Coordinates

By Graphic When checked, the start and end coordinates of the slot will be selected by the mouse

Back and Forth When checked, the tool will move from the start to the end point, and return to the start point
before lifting from the material
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Automatic Toolpaths

Overview

Automatic Toolpaths (ATP) in EnRoute allow parts contained in external DXF files to be processed for output. EnRoute's
Automatic Toolpath capabilities provide an efficient way to process large numbers of parts as part of a Nested-Based
Manufacturing (NBM) process.

Design Application Support

Several design applications are supported by EnRoute and new application support is added based on requests from
users, manufacturers, and customers.

The images in the ATP section must often show a specific design application as the active application. For sim-
plicity, KCD was chosen as the active application in the examples. This is not infended to provide a specific
recommendation or to exclude any other supported applications. References to the active application are

marked as <active application> or <KKCD> and should be interpreted as any design application can be used
in these references.

The ATP Process

DXF files supported by EnRoute separate each machining operation onto a different layer. The geometry within all layers
represents asingle part and all of the machining information. To process the part, the toolpath strategies in EnRoute must
be mappedto the correct DXF layerin the ATP.

EnRoute uses the strategy mappings to apply toolpaths to each piece of the part geometry. Parts are imported one at a
fime and toolpaths are created for each layer of geometry. They are then separated into different material types and
thicknesses, and then nested onto sheets using the selected nesting parameters. Machining output files are created
based on ordering and output preferences. Finally, labels are created if they have been specified, and summary prin-
touts are createdif they have beenrequested.

One of the key efficiencies of this process is that all of the layer mappings and processing parameters are stored in an
ATP configuration file that can automatically be loaded when the ATP is activated. When a job is created using most
popular design applications, it includes a List File that provides information about the parts and their corresponding geo-
metry files. This list file is used to load the partsinto the ATP, and then to subsequently process the parts.

When the ATP has been fully configured, processing a job becomes as easy as opening the ATP, loading the appropriate
list file, and clicking the Process Parts button.

ATP Dialog

=
U5

All of the ATP functions are accessed through the ATP dialog. The dialog window tabs represent the main ATP steps and
are arranged left fo right from the start of processing to configuring output files.

Start - This tab allows selection of the design application or other source for part information. It also provides for loading
and saving ATP configuration files.

Parts - This tab provides forloading parts using either job list files or loading individual DXF files.
Map - The Map tabis for selecting saves Strategies that will be applied fo part layers.
Material - Different materials and importantly, their thicknesses, are defined in this tab.

Processing - Parameters for nesting, double-sided processing, and labels are defined in this tab.
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Output - Finally, this tab provides ordering, output options, and file naming options for output files.

Start

Load an ATP parameters file and select the active application and part source to create output for.

Parameters

Active Choose the active supported design application. This only needs to be set once, EnRoute will remember
Applic- the selected application and won't be necessary reset it unless changing applications.

ation

Part o ) . L

s Application Process files from the active application

ource List File

Select Import  Select the DXF files that contain the part information
Files
Active Draw-  Process the parts in the currently active EnRoute design
ing

Load Load a saved ATP parameters file

ATP Fil-

e

Save Save changes to the currently loaded parameters file. If no parameter file is loaded, the Save As dia-

ATP Fil- logue will open

e

Save Save the current settings as a new ATP parameters file

ATP Fil-

e As

Clear Clear the loaded ATP settings and reset all fields to the default values
ATP

Selecting Parts

Parts can be loaded 3 different ways into the ATP dialogue. If using a specific design application, it can be selected from
the Design Application drop down menu. With a design application specified, the parts to process will be loaded from a
list file in the Parts tab of the ATP dialogue. The list file is a list of all of the DXF files to be processed, along with additional
information such as material, quantity, and rotation for each part.

If not using allist file from a supported design application, parts can be imported individually using the Selected Import
Files option and then by selecting each file in the Parts tab. The ATP can also be used to toolpath parts from the current
EnRoute workspace by selecting the Active Drawing opfion.

Loading an ATP File

ATP files can be used to save ATP settings to automatically configure future jobs. Layer mappings, strategies, nesting,
and output options can all be saved to an ATP file so processing a new job can be as simple as loading an ATP file and
generating output.

Parts

Select the files to be processed eitherindividually, or by loading a List File. Part output files from supported applications
include a List File that contains all of the information for the job including DXF file names, size, material, quantity, and rota-
fion. Each DXF file is automatically verified and the information is displayed in the table in the parts tab.
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Part Parameters

Use Process the part when checked
Part Name Part name definition, not editable
Width Part width

Length Part Length

Thickness Nominal part thickness

Material Part material, not editable

Type

Quantity Part Quantity, editable

Allow Rotate Allow the part to be rotated when nested, usually checked

Loading List Files

If a Design Application is selected in the Start tab, alist file input dialogue will be visible in the Parts tab. Select Add List File
fo open a dialogue window to select the list file location. The dialogue will automatically filter the view o display only list
filesin the correct format for the selected design application. Multiple list files can be added at once and allcan be
removed using the Clear button. When allist file is used, the part name, size, and material will be displayed. Once
loaded, the parts dialogue provides additional parameters that can be edited for enabling part output, quantity, and
allowing the part torotate.

If using selecting the partsindividually, files can be added using the Add Files button, which will opens a dialogue win-
dow to select DXF files. Files can be removed from the list using Delete Files fo remove selected files, or Clear foremove
all parts from the list.

Map

Each machining operationis separated into a different layerin the part XML files. Synchronize toolpath generation with
the XML files by mapping each layer to the correct toolpath strategy. This is the core step for defining automatic
tfoolpaths.

Forexample, alayer could be named CUTOUT, and it would contain the part perimeter. In the layer tab, arouting offset
would be associated with the CUTOUT layer. All parts loaded into the ATP with a CUTOUT layer would have a routing off-
set applied to geometry in the CUTOUT layer.

Layers can either be added one at a time, or they can be automatically imported from the loaded files using the
Use Parts button. The next step is to map toolpath strategies to each layer from the saved strategy tfemplates which can
be created from each toolpath strategy through the Strategy Dialogue.

Actions

Add Layer Add anew layer mapping

Remove Remove the selected layer mapping
Layer

Clear Lay- Remove all layer mappings
ers

Use Act- Populate the layers from the active EnRoute drawing
ive

Use Parts  Populate the layers from the parts loaded in the Parts tab
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Layer Parameters

Map Layer Name Layer name that corresponds to a machining operation layer in the part

Strategy Toolpath strategy assigned to the layer

Small Part Strategy Toolpath strategy assigned to the layer to be used when cutting small parts
(Optional)

TP - Toolpath Create toolpaths for this layer, usually checked.

NT - Nest Together Include this layer with the part defined by the DXF when nesting. When processing

files from supported applications, this option should always be checked.

OP - Output Include this layer with the part in the toolpath output. Usually checked. If unchecked,
the geometry information for that layer will not be included in the output.

FL - Flip The geometry on the selected layer is for the flip side of the material when utilizing 2
sided processing.

Design Depth and Use Depth

When Use Depth is checked, the depth of the geometry in the part file will be used to generate toolpaths. If Use Depth is
unchecked, the toolpaths for the layer geometry will be generated at the strategy depth.

Design Depth specifies the nominal depth the selected strategy was designed for. If the strategy was created to cut
0.75" thick material, Design Depth should be set to 0.75 and similarly, if the strategy was created to cut 0.5" material,
Design Depth should be set o 0.5.

If a strategy is designed to cut a material thatis 0.75" thick but the strategy depthis set to 0.77" to allow for 0.02" extra cut
depth to cut through the entire material, Design Depth would still be set to 0.75. If the same strategy is applied to a part
with thickness 0.25", the Design Depthis set to 0.75", and Use Depth is checked, the toolpaths will be output to a depth of
0.27".The strategy depth was designed for nominally 0.75" material but with 0.02" additional depth to create a complete
cut. When the same strategy is applied to 0.25" thick material, the ATP interprets that because the strategy depth was
designed with 0.02" addifional depth, the same additional depth should be applied to the 0.25" material.

Using the Design Depth and Use Depth parameters allows for creating fewer strategies that can be applied to different
depths of geometry. Otherwise, leaving Design Depth set to 0.0 and Use Depth checked will generate toolpaths at the
geometry depth specified in the part file.

Default Strategy
The default strategy applied fo layers without a strategy assigned.
Sheet Trim Strategy

The strategy used to trim the sheet edges when processing 2 sided cufts.

Material

Define the material types the parts will be cut from. Multiple types of material can be defined at once.

Default Material

A default materialis always defined as the first material. Any new materials will be created with the same dimensions as
the default material. The default material size is saved to the ATP file and will update when a new ATP file is loaded.

Actions
Add Add a new material definition
Remove Remove the selected material definition
Reset Reset the material parameters to the original settings
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Parameters

Material Material Name

Width X dimension of the material

Height Y dimension of the material

Thickness Default material thickness. Output for an active design application will automatically adjust the

thickness based on part thickness. If no design application is selected, this value will be used.

Processing

Specify specific processing parameters for part nesting, double sided parts, and labels.

Nest Options

Parts are grouped together for nesting based on the associated material type for each part. The nesting options define
how the parts are placed within each sheet of material.

Nest Method

Angle Steps

Gap*
Margin*
Use Holes

Nest Position

Select the EnRoute nester to use to nest the parts

The angle increment to rotate parts by when nesting. Larger values increase the number of
nesting options, but also increase nesting time

Minimum distance between nested parts
Minimum distance between nested parts and the edge of the material
Nest parts inside the holes of other parts when checked

Select the nesting position on the plate

* Overall part dimensions when nesting include any external toolpaths allowing nesting spacing parameters to be very
small or even 0.0 fo maximize material usage.

Double Sided Machining

Flip Direction

Horizontal Trim
Amount

Vertical Trim
Amount

Horizontal Edge

Vertical Edge

Label

Label Design

Label Format

The direction the material will be rotated when processing 2 sided geometry

The thickness of material timmed off the horizontal edge of the material to create an accurate
registration surface for flipping the material

The thickness of material timmed off the vertical edge of the material to create an accurate
registration surface for flipping the material

Select the top or bottom horizontal edge to trim

Select the left or right vertical edge to trim

Select a label design created by the Label Designer application in EnRoute

Select a label format

Labels on Flip Side Labels will be generated for the flip side output when double sided parts are processed
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Output

Define how the toolpaths should be ordered when output, how the output files should be created, and the output loc-
ation.

Parameters
Create Output Generate output for the loaded parts
Create printout of parts Create an image of each nested sheet with part names labeled and the name
of the corresponding output file
Create label output Create labels for each part based on the label design and format specified in
the Processing tab.
Process as single parts Generate a separate output file for each part
Create output sub directory Create a sub directory within the specified output folder with the date and
time in the name
Surface at (Top/Bottom) Select if the material surface for this job is set at the top or bottom. This can
be overridden for a specific machine driver by the Surface at Top of Plate
and Surface Override parameters in the Driver Selection dialog.
Output Path Open a dialogue to select the output path for all generated files
Output file name prefix Specify a prefix to append to all generated file names
Printer Select a printer to send the labels to
Output Results

After processing a job, an Output Results dialog will appear. The dialog will show the files that were created, the length of
cutin material, and the fime to cut the job.

Ordering

ATP output uses the common toolpath Ordering Dialogue to define the cut order. The ordering opfions apply the same
way to parts loaded in the ATP dialogue.
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Preview Output

Simulate 2D

2

Preview the toolpath outputin they will be sent to the machine. This provides a way to review the output before cutting
to make sure toolpaths are ordered correctly.

Controls
<« Rewind Rewind the simulation to the beginning
b Draw Next  Advance the simulation until the next segment is drawn
Segment
» Play Start the simulation and allow it to play to the end
pe Next Lift Advance the simulation to the next tool lift
po Next Tool Advance the simulation to the next tool change
\n
Done End the simulation and close the 2D simulation dialogue
4 Done
Order Order Display the Toolpath Ordering dialogue. Changes can be ma in the Priority

Ordering, Tool, Strategy, and Sort Method from the 2D Simulation tool and
reviewed. Click to Update Order button to apply changes
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1 Use the Up and Down arrow keys to speed up and slow down the simulation

Simulate Orthographic

>

Display and animated orthographic view of the path each tool will take in the defined order. This provides a way to
review toolpaths and toolpath order before cutting

Controls
Rewind
“
’ Draw Next
Segment
Pause
||
Next Lift
()
Next Tool
b3
Done
4 Done
Order Order

Rewind the simulation to the beginning

Advance the simulation until the next segment is drawn

Pause the simulation

Advance the simulation to the next tool lift

Advance the simulation to the next tool change

End the simulation and close the 2D simulation dialogue

Display the Toolpath Ordering dialogue. Changes can be ma in the Priority
Ordering, Tool, Strategy, and Sort Method from the 2D Simulation tool and
reviewed. Click to Update Order button to apply changes
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Simulate 3D

W

Simulate arendered view of the design oufput. All fool shapes are accurately rendered allowing both 2D and 3D
toolpaths to be rendered.

Simulation Options

Controls

Resolution

Material Color

Material Texture

Cut Color

Use selected contours
as mask

Save simulation as
relief

Simulation Tolerance

Rewind
“

The display resolution of the rendered image. Higher resolution will create more pixels
in the image and a clearer picture, but will take longer to display

The color of the rendered relief. Click on the color panel to select a new color

Select a bitmap texture to apply to the simulation. If no option is selected, the material
color will be used to render the simulation

Use Tool The colors assigned to each tool type will be used to
Color render cuts

Use Selected The selected color is shown to the right. Click the
Color color panel to select a new color

Use Material The material color will be used to render cuts
Color

When checked, any selected contours will be used as a mask for the area to simulate

The simulation will be saved as a relief and placed in the plate

How closely the simulation will display the relief toolpaths

Rewind the simulation to the beginning
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4 Done

Order

Draw Next
Segment

Pause

Next Lift

Next Tool

Done

Simulation

Options

Render

Order

Advance the simulation until the next segment is drawn

Pause the simulation

Advance the simulation to the next tool lift

Advance the simulation to the next tool change

End the simulation and close the 2D simulation dialogue

Open the simulation options dialogue

Toggle the rendered view

Display the Toolpath Ordering dialogue. Changes can be ma in the Priority
Ordering, Tool, Strategy, and Sort Method from the 2D Simulation tool and
reviewed. Click to Update Order button to apply changes
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Output to Machine

Generating Output

¥

Use the toolpaths created for a design to generate an output file or send data directly to a machine for manufacturing.

There are 3 steps fo generating Output:
1. Select the Machine Driver

2. Determine Cut Order

3. Select Output Parameters

When all 3 steps have been completed, click To File fo open a Save As window to save the output to a machine file.

Cut Statistics

(=

Generate areport for the currently active job that estimates the total time fo complete the job, based on the total dis-
tance covered, and machine specific parameters.

Cut Statistic Preferences

Before generating areport, the cut statistics estimator needs to be configured in Preferences, under the Cut Statistics
tab.

Cut Time Estimator Select which estimation method to use. Standard takes into account acceleration and
deceleration. Simplified and Legacy only estimate straight line speed along the contours.

Cut Factor A scaling factor to calibrate the estimation to match real world values.
Tool Change Interval  The required time to change tools
Maximum Speed Maximum machine movement speed

Acceleration Angles

The acceleration and deceleration angles approximate how quickly the machine changes speed and are only valid
when using the Standard estimator. 45 degrees is the defaulf value and represents a steady change in speed. Larger
angles will estimate that the machine changes speed more rapidly, and smaller angles will estimate that the machine
changes speed more slowly. This can be calibrated fo match estimation fimes fo real world machine times.

Cut Statistics Report

After defining the cut statistics preferences, reports can be generated to estimate job time. With toolpaths created in
the active workspace, activate the Cut Statistics fool to generate areport. The report has 3 main sections:

General

Generalinformation for the active job.

Line Count Number of straight line segments
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Arc Count Number of arc segments

Feed Count Number of movements in material

Rapid Count Number of movements above the material

Total Moves Total number of machine movements to job completion
Tool Changes Number of tool changes

Tool Lifts Number of Tool Lifts

Factor The scaling factor applied to the estimate

Distances

Estimates for the distance the machine will travel to complete the job.

Feed Movement distance in material
Distance

Rapid Movement distance above the material
Distance

Total Total distance covered for this job
Distance

Times

Estimates for time fo complete the job.

Feed Time The time spent in the mater-
ial

Rapid Time The time spent above the
material

Tool Change Time Time spent changing tools,

defined in preferences

Total Time Total estimated time to job
completion

Configure Machine Drivers

L |

Select and configure Machine Drivers for a specific machine.

Machine Drivers are also referred to as Post Processors. The driver or post processor interprets the output from

EnRoute and franslates it info a format that can be recognized by a specific machine.

In the Machine Drivers dialogue, select the driver to configure from the Current Driver list. The Current Driver list shows
drivers that have been marked as active; if the driver for a specific machine is not shown open the Active Drivers dia-
logue and add it to the list of active drivers.
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Parameters

Driver Description NETE

Model

Description

Driver Parameters Width

Height

Z Lift

Surface Override

Name of the driver file
Model of the driver

A brief description of the driver, such as the model of the
machine or the type of driver

Machine width
(typically the
X axis dimension)

Machine height
(typically the
Y axis dimension)

The maximum
Z axis dimension

Override

the surface at
Top/Bottom set-
ting in the plate
definition and
ATP and use the
parameter value
in the driver

Surface at Top of Plate Sets the surface

Primary Axis

at top of plate
when checked,
and bottom of
plate when
unchecked, when
the Surface Over-
ride parameter is
enabled

The machine
primary axis, for
use with the
Rotate for
Driver Primary
Axis in the
AutoTP Prefer-
ences. When
enabled, parts pro-
cessed by the
ATP will auto-
matically be
rotated to align
with the primary
axis.
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Driver Speeds Values in this category are limited by the machine capabilities so that it is not possible
to define a speed that the machine is not capable of. These values are set by the
manufacturer and it is not recommended to change them.

The units in this category are defined by the manufacturer based on the units used by
the conftrollers. It is not recommended to change the units.

Spindle Default spindle speed to use if no spindle speed is specified
Speed
Feed Default feed rates the machine moves in the X and Y axis if not

specified in toolpath output. Above the Material refers to
speeds moving between toolpaths and Within the Material
refers to speeds when cutting material.

Plunge Default Z axis speed moving in and out of cut.

Dwell A minimum dwell time after entering the material to allow the
tool to clear chips before beginning a cut.

Driver Units These are units set by the manufacturer that are expected by the machine controller.
As described above, itis not recommended to change these units.

The default units can be restored at any time by selecting the Use Defaults button.

Communication These parameters are used to communicate with the machine when sending output
Parameters directly and are defined by the manufacturer.

Many machines are not designed to receive information directly from the
software. Check with the manufacturer to find out what communication
parameters should be used if appropriate.

Do Not Change These Values unless you know for sure the changes are cor-
rect. If specified incorrectly, speeds and distances will not be com-
municated correctly to the machine

After a driveris configured it is typically not required fo edit the configuration again, except to change tools
loaded in a tool changer if the machine has one.

Configuring a Tool Changer

Specify if the selected machine has a tool changer and select the specific tools present.

Parameters
Auto Tool Changer Enables auto tool changer for the specific machine
Number of Tools Number of tools in the fool changer

Edit Tools Edit the specific tools loaded at each position in the fool changer

Add Tool Add a new tool in the selected position

Remove Tool Remove a tool from the selected pos-
ition

Empty Turret Clear all tool selections
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»  Use the drop down list for each position to select the type of tool loaded in that position

»  Click OK to accept the tool changer configuration

»  The Print TC button will print out a copy of the current tool changer configuration for use when setting up a

machine
Configuring a Drill Bank

Configure an available boring head as a drill bank. The configuration must match the machine configuration and drill
arrangement to function correctly. EnRoute also supports horizontal drills.

Check the Has drill bank parameter and click the Click to Edit button to open the drill bank configuration dialogue.
1. Setthe Number of drill tools that are present on the machine
2. ForEach Drill Tool:

a. Selectthe type of Drill Tool that is loaded into that position from the pull down list

Tools must be added to the Tool Library before they can be added to the drill bank

b. Definethe X, Y and Z location of the tool

c. Define the tool direction. Drills commonly point down in the -Z direction, but they can be configured to
pointin other cardinal directions fo match a machine configuration.

If Horizontal bores are used, it is very important that the machine driver is properly configured.
Please contact EnRoute Technical Support before implementing horizontal bores.

This location information is used to create the final output and it is very important itis correct. It may be
necessary fo get the location from the manufacturer.

3. Click OKto accept the drill bank configuration

After defining a drill bank, it can be disabled at any time by disabling the Has drill bank parameter. The drill bank con-
figuration parameters will be retained and reloaded the next time the drill bank is enabled.

Itisimportant to verify the selected driveris capable of supporting a drill bank. Not all drivers can support the

correct output commands. If unsure, check with the manufacturer or contact EnRoute Technical Support.

Output Parameters

Which Select One:
Toolpaths?
All All toolpaths will be output
Selected Only the current selection will be output
Depth Select One:
All Toolpaths at all depths will be output
[Specific Depth] Only cut passes at the specified depth will be output
Orientation Output the toolpaths rotated by 0, 90, 180, or 270 degrees
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Copies Not Supported, leave at 1

Hold Output When sending the output to the Output Control Center, hold the output in a queue so they con

be sent to the machine when ready.

Toolpath Ordering

Bo,

Review and edit the order assigned to tfoolpath groups. The toolpath orderinfluences the orderin which cuts will be
made.
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Ordering Toolpath Groups Manually
1. Inthe Order Toolpath dialogue, use the horizontal blue arrow buttons to select toolpaths. The selected toolpath is

indicated by a bold red number.

2. Use the vertical green arrow buttons to change the cut number of the selected toolpath.

3. Click OK when finished.

Pressing the arrow keys on the keyboard produces the same result as clicking on the blue and green arrows.

Order Manually using the Mouse

1. Select the Manual optionin the Order Toolpath diclogue.

2. Clickeachtoolpathin the desired order
3. Click OKwhen finished

Order Toolpath Groups Using Sorting Methods

Select the sorting method from the Current Sort Method list.

Shortest Produce the shortest overall set of toolpaths and movements
Rows Order toolpaths in rows starting at the bottom of the plate and numbering left to right
Columns

Order toolpaths in columns starting at the left of the plate and numbering top to bottom
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Inside Out Sort toolpaths by position from the center of the plate to the edges

Outside In Sort toolpaths by position from the edges of the plate to the center

Cut Order

The orderin which cuts are made determines the time to output a finished piece.

The default ordering options will create a high-quality finished piece and it is not necessary to edit the order-

ing. The ordering parameters only need to be changed to fine tune the process.

Priority
Set the priority levels of the major parameters relative fo each other.
Priority Options
Tool Type of cutting tool used to make the cut
Object The object that the cut forms a part of. In this context an object a piece that will be cut from the plate

Strategy The strategy the cut belongs to
Pass The cutting pass the cut belongs to
Layer The layer the cut belongs to

The orderlisted above is the default priority order, which is designed to minimize tool changes. If the output uses 2 tools,
all of the toolpaths associated with the first tool would be cut first, followed by all of the toolpaths with the second tool.

Entries in the Priority Order list can be changed by dragging them up or down the list by clicking on the row

header column on the leftf edge.

Cutting Each Object Completely Before Continuing

A common change to the priority order list is to cut out each object completely before moving on to the next object.
Moving Object to the top of the order will prioritize each object above the individual tools used to cut out the object. This
willincrease the number of tool changes, but that could be a valid fradeoffif it is more important to keep completed
parts moving through a shop.

Click Default Order to reset the Priority Order to the default

Tool Order

The Tools list displays all tools used in the design ranked from highest to lowest priority. Highest priority tools are used first
down to the lowest priority tool. A 1/4" end mill used to cut out pieces from the plate should be prioritized lowest so that all
other cuts can be made to a design before separating it from the plate.

Enfries in the Tool Priority list can be changed by dragging them up or down the list by clicking on the row

header column on the left edge.

Clearthe Use check box to the right of a tool to prevent any cuts using that tool from being output.
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Strategy Order

The Strategies list displays the different strategies within the design in priority order. Higher priority strategies are cuf first
and lower priority strategies are cut later.

Enfries in the Strategy Order list can be changed by dragging them up or down the list by clicking on the row

header column on the left edge.

Clearthe Use check box to the right of a strategy fo disable it from generating output. For example, if the same confours
are used to generate male and female Routing Offset toolpaths for aninlay job, each strategy willneed to be sent to the
machine atf a different fime. Mark one strategy as unused to generate output files for the other strategy.

Object Order

Choose how objects are prioritized. Object order uses the same dialogue as Toolpath Ordering.

Additional Ordering Options

Small Parts First Cut out small parts first

Maintain Grouping Treat grouped objects as a single reference in the cut order

Load and Save Ordering to Preferences

Ordering parameters can be saved o preferences and reloaded later by using the Load and Save Ordering to Prefer-
ences buttonsin the ordering dialogue. When Load Ordering is selected, the ordering parameters saved to preferences
will be loaded into the dialogue. When Save Ordering is selected, the parameters loaded in the dialogue will be saved
to EnRoute preferences, overwriting any previously saved ordering parameters.
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SAi Cloud

Accounts and Licenses

Manage your SAi cloud account and software licenses.

Logginginto your SAi Cloud Account

Browse to hitp://saicloud.com

Login

Email

Password

Forgot Password?

Enterin the email address and password you signed up with and click Login.

Change your email address

To change your email address, which is also your username, in the SAlcloud :

»  Loginto http://saicloud.com

»  Click Login Settings

»” Under Login Settings, click the Change emaiil link
» Type in a new email address

»  Typeinyour current password

» Click Send

Change your password

To change your password :

»  Loginto your saicloud account and click Login Settings

» Scrolldown to Set Password.
»”  Typeinanew password
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http://saicloud.com/

»
»

Retype the new password
Click Set Password

If you have forgotten your password

»
»
»

Browse to http://saicloud.com
Click the Forgot Password? link underneath the login section

Enterin your email address and click reset password

You willreceive an email with instructions to reset your password

Manage your subscription

If you have a EnRoute Subscription, you can manage your subscription from the SAi Cloud.

»
»
»

»

Browse to http://saicloud.com
Enter your user name (email address) and password
In your list of software, click the Manage button next to the Subscription

This will take you the overview of all your subscriptions with SAi

Depending on the type of subscription orits current state a number of actions are available :

Flexi Monthly Com-  Subscriptions with a monthly commitment are billed every month until you cancel them.
mitment Because your commitment is month to month, you can cancel at any time.

Cancel Subscription Cancels the subscription. The status of the sub-
scription will change to canceled and you will not be
billed the next month.

Update Payment Details Use this if your credit card has changed.

Annual contract Converts your subscription into an annual contract.
You will still be billed monthly but at the discounted
price. You will not be able to cancel your sub-
scription after converting to annual until the year is
over.

Invoice History Access your invoices in PDF format

Flexi Annual Com- Subscriptions with Annual Commitment are also billed every month. However, since
mitment you committed to pay for the subscription for the duration of 1 year you cannot can-
cel the subscription.

You can switch off Auto renewal, which will make sure that the subscription will can-

cel at the end of the year.

Switch Auto Renewal Off When auto renewal is switched off, the subscription
will cancel at the end of the year you committed to.

Update Payment Details Use this if your credit card has changed.

Invoice History Access your invoices in PDF format

Flexi Monthly Com- Subscriptions with a monthly commitment are billed every month until you cancel them.
Design mitment Because your commitment is month to month you can cancel at any time.
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Cancel Subscription Cancels the subscription. The status of the sub-
scription will change to canceled and you will not be
billed the next month.

Update Payment Details Use this if your credit card has changed.

Annual contract Converts your subscription into an annual contract.
You will still be billed monthly but at the discounted
price.

Invoice History Access your invoices in PDF format

Upgrade to Flexi Converts your license from a Flexi Design to a full

Flexi license. The same commitment as your cur-
rent license will apply. You will be billed the cor-
responding price for the Flexi license.

Flexi Annual Com- Subscriptions with Annual Commitment are also billed every month. However, since you

Design mitment committed to pay for the subscription for the duration of 1 year you cannot cancel the sub-
scription. You can switch off the Autorenewal, which will make sure that at the end of the
year the subscription will cancel.

Switch Auto Renewal Off When auto renewal is switched off, the subscription
will cancel at the end of the year you committed to.

Update Payment Details Use this if your credit card has changed.
Invoice History Access your invoices in PDF format
Upgrade to Flexi Converts your license from a Flexi Design to a full

Flexi license. The same commitment as your cur-
rent license will apply. You will be billed the cor-
responding price for the Flexi license.

» |fyou have canceled a subscription and would like to restart, you can do so at any time by choosing the Restart
Subscription option

Use the Manage Subscriptions page to cancel subscriptions. Do not cancel via email. The subscriptions plat-

formis a fully automated system but it is not capable of reading emails!

CloudTools

Review the available cloud toolsin EnRoute.

Artwork Approval

“ Facebook

Click the Facebookicon fo visit SA International's public page on Facebook. Here you will find photos, training videos,
news, and user questions and comments. Click the Like to follow SA International's activity link.
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F ]
Fa") Files

The Files option gives you at-a-glance information about the files you have stored in your account on the SAi Cloud. Files
are stored (archived) on the SAi Cloud server using the Archive to Cloud option found in the File Menu and on the Stand-
ard Toolbar. Jobs that were sent to approval will also be stored in your Cloud account.

To see what has been stored in your Cloud account, click the Filesicon.

The archive opensin the Cloud Window on the right side of your SAi product screen. The Summary section presents an
overview of your total file count, storage usage, and space availability. The Files section lists each of the files you cur-
rently have stored on the SAi Cloud. The files are listed in date order with the most recently archived file at the top of the
list. Each entry in the Files list contains a thumbnailimage of the file, its name, size (in kilobytes), and time of archival.

Note: A file having the same name as an existing archived file will not overwrite it. Instead, the new file will be stored as a
more recent version of the existing one. This serves as a safeguard againstinadvertent deletions and as a version control.

Additional options—Download and Delete This File—can be accessed by clicking anywhere on afile's information. Any
comments associated with the file will appearin the Comments section. And clicking Back To List will return you to the
Summary page.

The list contains all files that were sent to Cloud from all licenses that are linked to an account.

E License

Clicking this icon will display more information about your current license.

If your license is a subscription, you will also see a Manage button which you can use to update payment

details, pause or manage a subscription.

Reports

The Reports option keeps arunning total of the number of jobs your company has worked on during the past week and
month, and reports the total area for each period.

Under Recent Jobs, Reports displays a list of all the jobs you have worked on during the past thirty days.

To find more detailed information about a particular job, click oniit.

Support

The Support option takes you fo the SAi Software Support page, where you can access SA International's many support
resources.

To get started:

”  Move your mouse over your region.
» Point to your preferred language.

”  Select the software product that you own.

Troining

Clicking thisicon willopen a YouTube fraining video to help you get started with Flexi.

EnRoute User Manual - Page 190



You
UL YouTube

Click the YouTube icon to view TheSAIChannel on You Tube. Here you will find a number of video tutorials, product
reviews, tradeshow interviews, and more.

Click Subscribe to follow TheSAIChannel
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